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CHAPTER 1
INTRODUCTION TO HACKING

1.1 Hacking

The most fundamental meaning of hacking is gaining unauthorized access to data in a
system or computer.

Hacking is exploiting security controls either in a technical, physical or a human-based
element. ~ Kevin Mitnick

However, the word “hacking” has two definitions. The first definition refers to the
hobby/profession of working with computers. The second definition refers to modifies
computer hardware or software in a way that changes the creator’s original intent.

It is the art of exploiting computers to get access to otherwise unauthorized information.
Now that the world is using IT systems to gather, store and manipulate important
information there is also a need to make sure that data is secure. However, no system is
without is problems. Holes are often present within security systems which, if exploited,
allow hackers to gain access to this otherwise restricted information.

1.2 Hacker

Computer Hackers have been around for so many years. Since the Computer and Internet
became widely used in the World, We have started to hear more and more about hacking.

As the word ‘Hacking’ has two meaning, so the word ‘Hacker’ is a word that has two
meanings:

Traditionally, a Hacker is someone who likes to play with Software or Electronic Systems.
Hackers enjoy Exploring and Learning how Computer systems operate. They love
discovering new ways to work electronically.

Recently, Hacker has taken on a new meaning that someone who finds weaknesses in a
computer or computer network, though the term can also refer to someone with an
advanced understanding of computers and computer networks.

Normally, Hackers are people who try to gain unauthorized access to your computer.

With controversy, the term hacker is reclaimed by computer programmers who argue that



someone breaking into computers is better called a cracker, not making a difference
between computer criminals (black hats) and computer security experts (white hats). Some
white hat hackers claim that they also deserve the title hacker, and that only black hats
should be called crackers.

If hackers, if anyone committing a criminal act, wants to reduce their risk, they obviously
don't involve anybody else. The greater the circle of people that know what you’re doing,
the higher the risk. ~ Kevin Mitnick

1.3 Classifications of Hacker

There are many more types of hackers in the world according to their motive and type of
work. The following list forwards one mote steps to better knowing hackers.

White hat hacker

The term “White hat hacker” refers to an ethical hacker, or a computer security expert,
who specializes in penetration testing and in other testing methodologies to ensure the
security of an organization’s information systems. Ethical hacking is a term coined by
IBM meant to imply a broader category than just penetration testing. White-hat hackers
are also called penetration tester, sneakers, red teams, or tiger teams. Generally, White hat
hackers or ethical hackers are the good guy in the world of hackers.

Black hat hacker

A black hat hacker is an individual with extensive computer knowledge whose purpose is
to breach or bypass internet security. Black hat hackers are also known as crackers or
dark-side hackers. The general view is that, while hackers build things, crackers break
things. They are computer security hackers that break into computers and networks or also
create computer viruses. The term “black hat” comes from old westerns where the bad
guys usually wore black hats.

Black hat hackers break into secure networks to destroy data or make the network
unusable for those who are authorized to use the network.

They choose their targets using a two-pronged process known as the “pre-hacking stage”.
Step 1: Targeting

Step 2: Research and Information Gathering

Step 3: Finishing the Attack

Grey hat hacker

A grey hat hacker is a combination of a black hat and a white hat hacker. It may relate to
whether they sometimes arguably act illegally, though in good will, or to show how they
disclose vulnerabilities. They usually do not hack for personal gain or have malicious
intentions, but may be prepared to technically commit crimes during the course of their
technological exploits in order to achieve better security.



Elite hacker

A social status among hackers, elite is used to describe the most skilled. Newly discovered
activities will circulate among these hackers.

Script kiddie

A script kiddie (or skiddie) is a non-expert who breaks into computer systems by using
pre-packaged automated tools written by others, usually with little understanding of the
underlying concept hence the term script (i.e. a prearranged plan or set of activities) kiddie
(i.e. kid, child an individual lacking knowledge and experience, immature).

Neophyte

A neophyte, “n00b”, or “newbie” is someone who is new to hacking or phreaking and has
almost no knowledge or experience of the workings of technology, and hacking.

Blue hat

A blue hat hacker is someone outside computer security consulting firms who is used to
bug test a system prior to its launch, looking for exploits so they can be closed. Microsoft
also uses the term BlueHat to represent a series of security briefing events.

Hacktivist

A hacktivist is a hacker who utilizes technology to announce a social, ideological,
religious, or political message. In general, most hacktivism involves website defacement
or denial-of-service attacks.

Nation state

It refers to Intelligence agencies and cyber warfare operatives of nation states.
Organized criminal gangs

Criminal activity carried on for profit.

Bots

Automated software tools, some freeware, available for the use of any type of hacker.
What does it take to become a hacker?

Becoming a great hacker isn’t easy and it doesn’t happen quickly. Being creative helps a
lot. There is more than one way a problem can be solved, and as a hacker you encounter
many problems. The more creative you are the bigger chance you have of hacking a
system without being detected. Another huge quality you must have is the will to learn
because without it, you will get nowhere. Remember, Knowledge is power. Patience is also
a must because many topics can be difficult to grasp and only over time will you master
them.

1.4 Famous Hackers of All Time
Kevin Mitnick : a.k.a The Condor, The Darkside Hacker
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Kevin David Mitnick (born August 6, 1963) is an American computer security consultant,
author and hacker.

He was once the most wanted cybercriminal in the world. He had an obsession with
computers that escalated into a two and half year hacking spree where he stole millions of
dollars of corporate secrets from IBM, Motorola, telecom companies and even the
National Defense warning system.

At age 15, Mitnick used social engineering and dumpster diving to bypass the punch card
system used in the Los Angeles bus system. After a friendly bus driver told him where he
could buy his own ticket punch, he could ride any bus in the greater LA area using unused
transfer slips he found in the trash. Social engineering later became his primary method of
obtaining information, including user-names and passwords and modem phone numbers.

Mitnick first gained unauthorized access to a computer network in 1979, at 16, when a
friend gave him the phone number for the Ark, the computer system Digital Equipment
Corporation (DEC) used for developing their RSTS/E operating system software. He
broke into DEC’s computer network and copied their software, a crime he was charged
with and convicted of in 1988. He was sentenced to 12 months in prison followed by three
years of supervised release. Near the end of his supervised release, Mitnick hacked into
Pacific Bell voice mail computers. After a warrant was issued for his arrest, Mitnick fled,
becoming a fugitive for two and a half years.

According to the U.S. Department of Justice, Mitnick gained unauthorized access to
dozens of computer networks while he was a fugitive. He used cloned cellular phones to
hide his location and, among other things, copied valuable proprietary software from some
of the country’s largest cellular telephone and computer companies. Mitnick also
intercepted and stole computer passwords, altered computer networks, and broke into and
read private e-mail. Mitnick was apprehended on February 15, 1995, in Raleigh, North
Carolina. He was found with cloned cellular phones, more than 100 clone cellular phone
codes, and multiple pieces of false identification.

In 1999, he was convicted of various computer and communications-related crimes. At the
time of his arrest, he was the most-wanted computer criminal in the United States.
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Since 2000, Mitnick has been a paid security consultant, public speaker and author. He
does security consulting for Fortune 500 companies, performs penetration testing services
for the world’s largest companies and teaches Social Engineering classes to dozens of
companies and government agencies.

Vladimir Levin : a.k.a Vova
First internet bank robber

He is a Russian-born Jewish individual famed for his involvement in the attempt to
fraudulently transfer USD 10.7 million via Citibank’s computers.

He was delivered into U.S. custody in September 1997, and tried in the United States
District Court for the Southern District of New York. In his plea agreement he admitted to
only one count of conspiracy to defraud and to stealing US$3.7 million. In February 1998
he was convicted and sentenced to three years in jail, and ordered to make restitution of
US$240,015. Citibank claimed that all but US$400,000 of the stolen US$10.7 million had
been recovered.

In 2005 an alleged member of the former St. Petersburg hacker group, claiming to be one
of the original Citibank penetrators, published under the name ArkanoiD a memorandum
on popular Provider.net.ru website dedicated to telecom market. According to him, Levin
was not actually a scientist (mathematician, biologist or the like) but a kind of ordinary
system administrator who managed to get hands on the ready data about how to penetrate
in Citibank machines and then exploit them.

ArkanoiD emphasized all the communications were carried over X.25 network and the



Internet was not involved. ArkanoiD’s group in 1994 found out Citibank systems were
unprotected and it spent several weeks examining the structure of the bank’s USA-based
networks remotely. Members of the group played around with systems’ tools (e.g. were
installing and running games) and were unnoticed by the bank’s staff. Penetrators did not
plan to conduct a robbery for their personal safety and stopped their activities at some
time. One of them later handed over the crucial access data to Levin (reportedly for the
stated $100).

In 2005 an anonymous hacker group came claiming that they were the ones truly
responsible for the theft and that they only sold Vladimir the data needed to steal the
money.

Gary Mckinnon : a.k.a Solo

He was known by his Internet handle, “Solo.” Using that name, he coordinated what
would become the largest military computer hack of all time. The allegations are that he,
over a 13-month period from February 2001 to March 2002, illegally gained access to 97
computers belonging to the U.S. Armed Forces and NASA.

He claimed that he was only searching for information related to free energy suppression
and UFO activity cover-ups. But according to U.S. authorities, he deleted a number of
critical files, rendering over 300 computers inoperable and resulting in over $700,000 in
damages.

Being of Scottish descent and operating out of the United Kingdom, he was able to dodge
the American government for a time. As of today, he continues to fight against extradition
to the United States.

Mathew Bevan (a.k.a Kuji) and Richard Pryce (a.k.a Datastream Cowboy)

This British hacking duo took the U.S. government for a ride when they attacked the
Pentagon’s network for several weeks in 1994. They copied battlefield simulations from
Griffiss Air Force Base in New York, intercepted messages from U.S. agents in North
Korea, and got access into a Korean nuclear facility. Pryce was a 16-year-old then, and
Bevan was 21 (he’s thought to have been tutoring Pryce).

The hacking attacks were especially troublesome for the U.S. government because they
couldn’t tell if the duo was using their system to hack into a South or North Korea - if it



were North Korea, the attacks could’ve been seen as an act of war. Luckily, South Korea
was the hackers’ target, and after an international investigation, they were arrested in the
following year.

Michael Calce : a.k.a MafiaBoy

He was a high school student from West Island, Quebec, who launched a series of highly
publicized denial-of-service attacks in February 2000 against large commercial websites,
including Yahoo!, Fifa.com, Amazon.com, Dell, Inc., E¥XTRADE, eBay, and CNN. He also
launched a series of failed simultaneous attacks against 9 of the 13 root name servers.

On February 7, 2000, Calce targeted Yahoo! with a project he named Rivolta, meaning
“riot” in Italian. Rivolta was a denial-of-service attack in which servers become
overloaded with different types of communications to the point where they shut down
completely. At the time, Yahoo! was a multibillion dollar web company and the top search
engine. Mafiaboy’s Rivolta managed to shut down Yahoo! for almost an hour. Calce’s goal
was, according to him, to establish dominance for himself and TNT, his cybergroup, in the
cyberworld. Buy.com was shut down in response. Calce responded to this in turn by
bringing down Ebay, CNN, Amazon and Dell.com via DDoS over the next week.

In a 2011 interview, Calce tried to redeem his image by saying that the attacks had been
launched unwittingly, after inputting known addresses in a security tool he had
downloaded from a repository on the now defunct file-sharing platform Hotline,
developed by Hotline Communications. Calce would then have left for school, forgetting
the application which continued the attacks during most of the day. Upon coming home
Calce found his computer crashed, and restarted it unaware of what had gone on during
the day. Calce claimed when he overheard the news and recognized the companies
mentioned being those he had inputted earlier in the day that he “started to understand
what might have happened”.

Adrian Lamo : a.k.a The Homeless hacker

He was a mobile hacker who launched his work from the confines of Internet cafes,
libraries or coffee shops. He actually did it just as a challenge and for fun, as he would
regularly break into computer systems and then immediately tell the owner of the network



about its vulnerability. He even made himself an expert by adding his name to the
database of the New York Times.

Lamo first gained media attention for breaking into several high-profile computer
networks, including those of The New York Times, Yahoo!, and Microsoft, culminating in
his 2003 arrest. In 2010, Lamo reported U.S. soldier PFC Bradley Manning (now known
as Chelsea Manning) to federal authorities, claiming that Manning had leaked hundreds of
thousands of sensitive U.S. government documents to WikiLeaks. Manning was arrested
and incarcerated in the U.S. military justice system and later sentenced to 35 years in
confinement.

Jeanson James Ancheta : a.k.a Resilient

He became the first person to be charged for controlling large numbers of hijacked
computers or botnets on May 9, 2006.

In 2004 he started to work with botnets rxbot, a computer worm that can spread his net of
infected computers which gave him control to 500,000 computers including US military
computers.

In November 2005 he was captured in an elaborate sting operation when FBI agents lured
him to their local office on the pretext of collecting computer equipment. The arrest was
part of the Operation Bot Roast.

On May 9, 2006 Ancheta pleaded guilty to four felony charges of violating United States
Code Section 1030, Fraud and Related Activity in Connection with Computers. Ancheta
must serve 60 months in prison, forfeit a 1993 BMW and more than $58,000 in profit. He
must also pay restitution of $15,000 US to the U.S. federal government for infecting the
military computers.

Jonathan James : a.k.a cOmrade

He (December 12, 1983 — May 18, 2008) was an American hacker who was the first
juvenile incarcerated for cybercrime in the United States. The South Florida native was 15
years old at the time of the first offense and 16 years old on the date of his sentencing.




What is his ticket to fame? He was convicted and sent to prison for hacking in the United
States—all while he was still a minor. At only fifteen years of age, he managed to hack into
a number of networks, including those belonging to Bell South, Miami-Dade, the U.S.
Department of Defense, and NASA.

Yes, James hacked into NASA’s network and downloaded enough source code to learn
how the International Space Station worked. The total value of the downloaded assets
equaled $1.7 million. To add insult to injury, NASA had to shut down their network for
three whole weeks while they investigated the breach, which cost them $41,000.

The story of James has a tragic ending, however. In 2007, a number of high profile
companies fell victim to a massive wave of malicious network attacks. Even though James
denied any involvement, he was suspected and investigated. In 2008, James committed
suicide, believing he would be convicted of crimes that he did not commit.

Albert Gonzalez

He paved his way to Internet fame when he collected over 170 million credit card and
ATM card numbers over a period of 2 years. Yep. That’s equal to a little over half the
population of the United States.

He started off as the leader of a hacker group known as ShadowCrew. This group would
go on to steal 1.5 million credit card numbers and sell them online for profit. ShadowCrew
also fabricated fraudulent passports, health insurance cards, and birth certificates for
identity theft crimes totaling $4.3 million stolen.

The big bucks wouldn’t come until later, when Gonzalez hacked into the databases of TJX
Companies and Heartland Payment Systems for their stored credit card numbers. In 2010,
Gonzalez was sentenced to prison for 20 years (2 sentences of 20 years to be served out
simultaneously).

Kevin Poulsen : a.k.a Dark Dante

He gained his fifteen minutes of fame by utilizing his intricate knowledge of telephone
systems. At one point, he hacked a radio station’s phone lines and fixed himself as the



winning caller, earning him a brand new Porsche. According to media, he was called the
“Hannibal Lecter of computer crime.”

He then earned his way onto the FBI’s wanted list when he hacked into federal systems
and stole wiretap information. Funny enough, he was later captured in a supermarket and
sentenced to 51 months in prison, as well paying $56,000 in restitution.

Like Kevin Mitnick, Poulsen changed his ways after being released from prison. He began
working as a journalist and is now a senior editor for Wired News. At one point, he even
helped law enforcement to identify 744 sex offenders on MySpace.

Anonymous

The concept of being a “digital Robin Hood” was far from being conceived, but in the
computer age, it is very likely that someone somewhere has bagged this title. A “hacktivist
group” called Anonymous are known with the penname of being the “digital Robin Hood”
amongst its supporters. Identified in public by wearing a Guy Fawkes Masks, Anons, as
they are widely known, have publicized themselves by attacking the government, religious
and corporate websites. The Vatican, the FBI, the CIA, PayPal, Sony, Mastercard, Visa,
Chinese, Israeli, Tunisian, and Ugandan governments have been amongst their targets.
Although, Anons have been arguing whether to engage in a serious activism or a mere
entertainment, many of the group members have clarified their intent which is to attack
internet censorship and control.

Anonymous originated in 2003 on the imageboard 4chan, representing the concept of
many online and offline community users simultaneously existing as an anarchic, digitized
global brain.

Beginning with 2008’s Project Chanology—a series of protests, pranks, and hacks
targeting the Church of Scientology—the Anonymous collective became increasingly
associated with collaborative hacktivism on a number of issues internationally. Individuals
claiming to align themselves with Anonymous undertook protests and other actions
(including direct action) in retaliation against anti-digital piracy campaigns by motion
picture and recording industry trade associations.

In 2012, Time called Anonymous one of the “100 most influential people” in the world.

Anons have publicly supported WikiLeaks and the Occupy movement. Related groups
LulzSec and Operation AntiSec carried out cyberattacks on US government agencies,
media, video game companies, military contractors, military personnel, and police
officers, resulting in the attention of law enforcement to the groups’ activities. It has been
described as being anti-Zionist, and has threatened to erase Israel from the Internet and
engaged in the “#Oplsrael” cyber-attacks of Israeli websites on Yom HaShoah (Holocaust



Remembrance Day) in 2013.

LulzSec

LulzSec or Lulz Security, a high profile, Black Hat hacker group, gained credentials for
hacking into Sony, News International, CIA, FBI, Scotland Yard, and several noteworthy
accounts. So notorious was the group that when it hacked into News Corporations
account, they put across a false report of Rupert Murdoch having passed away. While the
group claims to have retired from their vile duties, the motto of the group, “Laughing at
your security since 2011!” stays alive. There are assertions of the group having hacked
into the websites of the newspapers like The Times and The Sun to post its retirement
news. Many, however, claim that this group had taken it upon itself to create awareness
about the absence of efficient security against hackers.

One of the founders of LulzSec was a computer security specialist who used the online
moniker Sabu. The man accused of being Sabu has helped law enforcement track down
other members of the organization as part of a plea deal. At least four associates of
LulzSec were arrested in March 2012 as part of this investigation. British authorities had
previously announced the arrests of two teenagers they allege are LulzSec members T-
flow and Topiary.

Astra

Astra, a Sanskrit word for weapon was the penname of a hacker who dealt in the weapon
stealing and selling. A 58-year-old Greek Mathematician hacked into the systems of
France’s Dassault Group, stole vulnerable weapons technology data and sold it to different
countries for five long years. While the real identity of the ASTRA remains untraced,
officials have said that he had been wanted since 2002. Astra sold the data to
approximately 250 people from around the globe, which cost Dassault $360 millions of
damage.

1.5 Types of hacking attacks and techniques
A typical approach in a hacking attack on Internet-connected system is:

e Network enumeration: Discovering information about the intended target.

e Vulnerability analysis: Identifying potential ways of attack.

e Exploitation: Attempting to compromise the system by employing the vulnerabilities
found through the vulnerability analysis.

In order to do so, there are several recurring tools of the trade and techniques used by



computer criminals and security experts.
Security exploits

A security exploit is a prepared application that takes advantage of a known weakness.
Common examples of security exploits are SQL injection, Cross Site Scripting and Cross
Site Request Forgery which abuse security holes that may result from substandard
programming practice. Other exploits would be able to be used through FTP, HTTP, PHP,
SSH, Telnet and some web-pages. These are very common in website/domain hacking.

Techniques of hacking
Vulnerability scanner

A vulnerability scanner is a tool used to quickly check computers on a network for known
weaknesses. Hackers also commonly use port scanners. These check to see which ports on
a specified computer are “open” or available to access the computer, and sometimes will
detect what program or service is listening on that port, and its version number. (Note that
firewalls defend computers from intruders by limiting access to ports/machines both
inbound and outbound, but can still be circumvented.)

Password cracking

Password cracking is the process of recovering passwords from data that has been stored
in or transmitted by a computer system. A common approach is to repeatedly try guesses
for the password.

Packet sniffer

A packet sniffer is an application that captures data packets, which can be used to capture
passwords and other data in transit over the network.

Spoofing attack (Phishing)

A spoofing attack involves one program, system, or website successfully masquerading as
another by falsifying data and thereby being treated as a trusted system by a user or
another program. The purpose of this is usually to fool programs, systems, or users into
revealing confidential information, such as user names and passwords, to the attacker.

Rootkit

A rootkit is designed to conceal the compromise of a computer’s security, and can
represent any of a set of programs which work to subvert control of an operating system
from its legitimate operators. Usually, a rootkit will obscure its installation and attempt to
prevent its removal through a subversion of standard system security. Rootkits may



include replacements for system binaries so that it becomes impossible for the legitimate
user to detect the presence of the intruder on the system by looking at process tables.

Trojan horses

A Trojan horse is a program which seems to be doing one thing, but is actually doing
another. A trojan horse can be used to set up a back door in a computer system such that
the intruder can gain access later. (The name refers to the horse from the Trojan War, with
conceptually similar function of deceiving defenders into bringing an intruder inside.)

Viruses

A virus is a self-replicating program that spreads by inserting copies of itself into other
executable code or documents. Therefore, a computer virus behaves in a way similar to a
biological virus, which spreads by inserting itself into living cells. While some are
harmless or mere hoaxes most computer viruses are considered malicious.

Worms

Like a virus, a worm is also a self-replicating program. A worm differs from a virus in that
it propagates through computer networks without user intervention. Unlike a virus, it does
not need to attach itself to an existing program. Many people conflate the terms “virus”
and “worm”, using them both to describe any self-propagating program.

Key loggers

A key logger is a tool designed to record (‘log’) every keystroke on an affected machine
for later retrieval. Its purpose is usually to allow the user of this tool to gain access to
confidential information typed on the affected machine, such as a user’s password or other
private data. Some key loggers uses virus, trojan, and rootkit-like methods to remain
active and hidden. However, some key loggers are used in legitimate ways and sometimes
to even enhance computer security. As an example, a business might have a key logger on
a computer used at a point of sale and data collected by the key logger could be used for



catching employee fraud.
1.6 Password
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A password is a secret series of characters that enables a user to access a file, computer, or
program. On multi-user systems, each user must enter his or her password before the
computer will respond to commands. The password helps ensure that unauthorized users
do not access the computer. In addition, data files and programs may require a password.

Ideally, the password should be something that nobody could guess. In practice, most
people choose a password that is easy to remember, such as their name or their initials.
This is one reason it is relatively easy to break into most computer systems.

Strong Password

Strong Password refers to a password that is difficult to detect by both humans and
computer programs, effectively protecting data from unauthorized access. It consists of at
least six characters (and the more characters, the stronger the password) that are a
combination of letters, numbers and symbols (@, #, $, %, etc.) if allowed. Passwords are
typically case-sensitive, so a strong password contains letters in both uppercase and
lowercase. Strong passwords also do not contain words that can be found in a dictionary
or parts of the users own name.

Weak password

A weak password refers to a password that is easy to detect both by humans and by
computer. Examples of a weak password are names, birth dates, phone numbers, easy
guessable word, etc.

CHAPTER 2
WINDOWS HACKING

2.1 Introduction to Windows Hacking

Windows hacking is the practice of modifying Windows Operating System to accomplish
a goal outside of the creator’s original purpose. People who engage in hacking activities
are often called hackers. Since the word “hack” has long been used to describe someone
who is incompetent at his/her profession, some hackers claim this term is offensive and



fails to give appropriate recognition to their skills. Windows hacking is most common
among teenagers and young adults, although there are many older hackers as well.

2.2 Registry Editor Related Hacking

What is Windows Registry? (Registry Editor)
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Windows Registry is a database used to store information that is necessary to configure

the system for one or more users, applications and hardware devices and it keeps record of
the settings of all the Software installed in Computer including Operating System.

To open Registry Editor: Start > All Programs > Accessories > Run > regedit

File Edit View Fgvontes |Help

4 B Computer
HKEY_CLASSES_ROOT
HEEY_CURFENT_LISER

HEEY_LOCAL MATHIME

HKEY_USERS
HEEY_CURRENT_COMFG

Registry Editor Window

Windows Registry contains Five Hives and hives contain Keys and Sub keys and their
respective Values.

HKEY_CLASSES _ROOT: The information that is stored here makes sure that the
correct program opens when you open a file by using Windows Explorer.

HKEY_CURRENT_USER: Contains the configuration information for the user who is
currently logged on. The user’s folders, screen colors, and Control Panel settings are
stored here.

HKEY_LOCAL_MACHINE: Contains configuration information particular to the
computer (for any user).

HKEY_USERS: Contains all the actively loaded user profiles on the computer.
HKEY_CURRENT_USER is a subkey of HKEY_USERS.

HKEY_CURRENT_CONFIG: Contains information about the hardware profile that is
used by the local computer at system startup.

Types of Keys

Binary Value (REG_BINARY): Raw binary data. Most hardware component
information is stored as binary data and is displayed in Registry Editor in hexadecimal
format

DWORD Value (REG_DWORD): Data represented by a number that is 4 bytes long (a
32-bit integer). Can also contain binary, hexadecimal, or decimal format



Expandable String Value (REG_EXPAND_SZ): A variable-length data string. This data
type includes variables that are resolved when a program or service uses the data

String Value (REG_SZ): A fixed-length text string

Multi-String Value (REG_MULTI_SZ): Values that contain lists or multiple values in a
form that people can read are generally this type.

Disclaimer: Modifying the registry can cause serious problems that may require you to
reinstall your operating system. We cannot guarantee that problems resulting from
modifications to the registry can be solved. Use the information provided at your own risk.

Back up the registry

Before you make changes to a registry key or subkey, we recommend that you export, or
make a backup copy, of the key or sub key. You can save the backup copy to a location
you specify, such as a folder on your hard disk or a removable storage device. If you make
changes that you want to undo, you can import the backupcopy.

1. Open the Registry Editor by clicking the Start button, typing regedit into the
search box, and then pressing Enter.

2. Locate and click the key or subkey that you want to back up.

3. Click the File menu, and then click Export.

4. In the Save in box, select the location where you want to save the backup copy to,
and then type a name for the backup file in the Filenamebox.

5. Click Save.

Tips:

e You must be logged on as an administrator to perform these steps. If you aren’t
logged in as an administrator, you can only change settings that apply to your user
account.

e Although you can back up more than just the registry key or subkey that you are
modifying, doing so adds to the size of the backup file.

Ultra-speed Shutdown of Windows 7
Follow the following steps to shutdown your Computer with ultra-speed

1. Open the Registry Editor by clicking the Start button, typing regedit into the
search box, and then pressing Enter.

2. In left pane of Registry Editor, go to
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control

3. In the right pane, right click on WaitToKillServiceTimeout and click on Modify.



Type in a number between 2000-20000 (2-20 seconds) and click on OK.
NOTE: The default time is 12000 (12 seconds).

Close regedit.
After rebooting (restart) Windows the new settings will take effect. The time to wait
for terminating services will be faster and shutdown won’t drag on forever.

NOTE: If you have problems with programs from your computer shutting down too
quickly, then repeat the above steps and increase the time (Step 5) a bit.

Change the log-on screen of Windows 7

1.
2.

w

7.

Press Windows Logo key + R to open Run, type regedit and press Enter.

Go to:
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Aut|
LogonUI\Background

Double-click the OEMBackground DWORD key and Set value of the key to 1.
Select a background image for logon screen with size less than 256 KB and Rename
that image as BackgroundDefault.

Copy that image, Open My Computer and go to
C:\Windows\system32\oobe\info\backgrounds folder

Paste it and select Copy and Replace.

Tips: Cut and paste the original log-on Screen image in a folder for further use.

Reboot, and now your logon image would have changed.

Disable or Enable USB Ports/USB drive/Pen-Drive in Windows 7

It’s really very easy to enable and disable a USB port of your Laptop and desktop
computer. Many companies disabled their employee’s laptop to prevent data threat. Also
many schools, colleges and universities block the USB ports of their computer. So, here is
the easy way to enable USB ports, access it and disable it back.

1.

Open the Registry Editor by clicking the Start button, typing regedit into the search



box, and then pressing Enter.

2. In left pane of Registry Editor, go to
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Servicess\sUSBSTOR
3. Right Click Start and Click Modify on right pane of Registry Editor.
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4. Do one of the following:
e To enable USB ports: change the value from 4 to 3
e To disable USB ports: change the Value from 3 to 4
5. After rebooting (restart) Windows the new settings will take effect. The time to

wait for terminating services will be faster and shutdown won’t drag on forever.

How to Display Legal Notice on Start up of your Windows

If your PC has multiple users then you can display legal notice to every user before they
login to your PC. This legal notice will be displayed at every startup just before the
Desktop is loaded. Using this you can tell your friends about the do’s and don’ts in your
computer when they login in your absence. To do this:

1.
2.

Click on Start button and type regedit and press Enter
Navigate to the following key in the registry

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion'

On the right side pane look for legalnoticecaption, double click on it and enter the
desired Legal Notice Caption.

Next below this look for legalnoticetext and enter the desired Legal Notice Text.
The legal notice text can be up to a page in its size so that it can include a set of do’s
and don’ts for your computer.

After you does this just restart your computer and upon the next startup you can see
the legal notice information for your computer.

Faster Thumbnail Previews

The taskbar shows thumbnail previews of opened windows when you hover the mouse



over the program icon. By default, it takes a little time for the preview to appear. Make the
previews appear faster with this registry tweak:

| [ Hashong Taps aea tricks, - Miscro.
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1. Open the Registry Editor by clicking the Start button, typing regedit into the
search box, and then pressing Enter.

2. Navigate to HKEY_CURRENT_USER\Control Panel\Mouse.

3. On the right, open the MouseHoverTime key and reduce its value from the default
400 to around 150. (Be careful, as decreasing the key further may cause problems.)

4. After rebooting (restart) Windows the new settings will take effect.

Disable Right-Click

This trick removes the context menu that would normally appear when the user right
clicks on the desktop or in the Explorer right results pane.

1. Open the Registry Editor by clicking the Start button, typing regedit into the
search box, and then pressing Enter.

2. Browse to this key in the registry:

HKEY_Current_User\Software\Microsoft\Windows\CurrentVersion\Policies\Ex]

Change the value of NoViewContextMenu to 1.

4. Now close the registry editor and restart your computer after any changes to go into
effect.

w

Tips: If NoViewContextMenudoesn’t exist then you can create it. Right click in the right-
hand pane; select New, then DWORD (32-bit) Value for 32 bit on Windows 7.

How to Disable or Enable Folder Options in Windows 7
Disable Folder Options in Windows 7

1. Click the Start button, and type regedit in the search box.
2. Browse the list as

HKEY_CURRENT _USER\Software\Microsoft\Windows\Current
Version\Policies\Explorer
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3. Create a new 32-bit DWORD value.
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4. Name it NoFolderOptions.
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5. Double click on it to set its value data to 1.

Edit DAWORD (32-bit) Yalue =
Vb name:
HaFolfeCypsana
'Viske data Base
. =
Deciral
Lok || Cence

Enable Folder Options in Windows 7

Double click on the value named NoFolderOptions to set its value data to 0.

Clean up the “Open With” Menu in Explorer

Have you ever accidently opened an mp3 with Notepad, or a zip file with Word? If so,
you’re also likely irritated that these programs now show up in the Open with menu in



Windows Explorer every time you select one of those files. Whenever you open a file
type with a particular program, Windows will add an entry for it to the Open with menu.
Usually this is helpful, but it can also clutter up the menu with wrong entries. On our
computer, we have tried to open a PDF file with Word and Notepad, neither which can
actually view the PDF itself. Let’s remove these entries. To do this, we need to remove
the registry entries for these programs.

1. Enter regedit in your Start menu search or in the Run command to open the
Registry editor.

Tips: Backup your registry first just in case, so you can roll-back any changes you make if
you accidently delete the wrong value.

2. Now, browse to the following key:

HKEY_CURRENT_USER \Software \Microsoft \Windows \CurrentVersion \
Explorer \FileExts\

3. Now, you will see a list of all the file extensions that are registered on your computer.
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4. Browse to the file extension you wish to edit, click the white triangle beside it to see
the subfolders, and select OpenWithList. In our test, we want to change the
programs associated with PDF files, so we select the OpenWithList folder under
pdf.

5. Notice the names of the programs under the Data column on the right. Right-click
the value for the program you don’t want to see in the Open With menu and select
Delete.

6. Click Yes at the prompt to confirm that you want to delete this value.

7. Repeat these steps with all the programs you want to remove from this file type’s
Open with menu. You can go ahead and remove entries from other file types as well
if you wish.

8. Restart the computer and check out the Open with menu in Explorer again. Now it
will be much more streamlined and will only show the programs you want to see.

Add Recycle Bin to My Computer in Windows 7



To add the Recycle Bin on My Computer, follow the steps:

1. Open up regedit.exe through the start menu search or run box

2. Goto:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\

3. Now right-click and create a New Key
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4. Name the key with the following text as shown in the below figure:

{645FF040-5081-101B-9F08-00AA002F954E}
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5. Close the Registry Editor and Open My Computer.

Add Control Panel to My Computer in Windows 7
To add the Control Panel on My Computer, follow the steps:

1. Open up regedit.exe through the start menu search or run box

2. Go to:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\

3. Now right-click and create a New Key
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4. Name the key with the following text as shown in the below figure

{26EE0668-A00A-44D7-9371-BEB064C98683}

Or

{21EC2020-3AEA-1069-A2DD-08002B30309D}

Tips:

e Category View
{26EE0668-A00A-44D7-9371-BEB064C98683}

e Icon View

{21EC2020-3AEA-1069-A2DD-08002B30309D }
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5. Close the Registry Editor and Open My Computer.

2.3 Local Group Policies Related Hacking
Want to know: What happened in your absences on your PC?

1. Press Windows logo key + R to open Run

2. Type eventvwr.msc and press Enter. Then Event Viewer window will open.
(Events are stored in three log files: Application, Security, and System. These logs
can be reviewed and archived. For our purposes we want the System log. )
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4. Look for a date and time when you weren’t home and your computer should have
been off. Double click on the eg: Information and it will show u the detail.

Tips: You can also use this log to see how long someone was on the computer. Just look at
the time the computer was turned on and off for that day.

How to Disable Shutdown, Restart, Sleep and Hibernate

Someday, you might want to make a computer could not be turned off easily. For example
because you are running a program that needs a long time to wait (download a big file,
rendering a video, etc.) and you have to leave the room. To prevent anyone else to turn off
the computer, then one way is to disable the function of Shutdown, Restart, Sleep or
Hibernate menu.

Follow these easy steps to disable Shutdown, Restart, Sleep and Hibernate:

1. Click Start button, type gpedit.msc in the Start menu’s search box and then press
Enter. Local Group Policy editor window will open.

Go to User Configuration > Administrative Templates > Start Menu And
Taskbar
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3. In the right pane, find the Remove and Prevent Access to the shutdown, Restart,
Sleep, and Hibernate. Then double click on it.
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4. Select Enable, and then click OK.
Tips:

e To make it back in to the normal function, just follow all the steps above, except for
the last one; you need to change back the option from Enable to Disable.

e When being in a state of disable, in fact we can still shutdown the computer. The way
is by typing the below instructions in the search (Windows 7) and press Enter.

shutdown /s (for shutdown)

shutdown /r (to restart)

How to Disable Access to the Registry in Windows 7

If you don’t know what you’re doing in the Registry, you can mess up your computer
pretty good. This trick helps you to prevent users from accessing the Registry and making
any changes to it.

To do this using Local Group Policy Editor:

Tips: This method uses Group Policy Editor which is not available in Home versions of
Windows.

1. Type gpedit.msc into the Search box in the Start menu

2. When Group Policy Editor opens, navigate to User Configuration \ Administrative
Templates then select System. Under Setting in the right panel double-click on
Prevent access to registry editing tools.
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3. Select the radio button next to Enabled, click OK, then close out of Group Policy
Editor.

4. Now if a user tries to access the Registry, Then he will get the following message
advising they cannot access it.

E# Registry Editar o

6 Registry editing has been disabled by your administrator,

Prevent access to the command prompt
This trick helps you to prevent users from accessing the Command prompt.

1. Type gpedit.msc into the Search box in the Start menu

2. When Group Policy Editor opens, navigate to User Configuration \
Administrative Templates then select System. Under Setting in the right panel
double-click on Prevent access to the command prompt.
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3. Select the radio button next to Enabled, click OK, and then close out of Group
Policy Editor.

How to show or hide Control Panel items in Windows 7

One of the common lock down’s that administrator apply to Remote Desktop Services
Servers is to remove all but the essential control panel items. The .cpl (e.g. timedate.cpl)
file name of the control panel item you wanted to show or hide however this has changed



in Windows 7 and you now need to use the Canonical Name when hiding or showing
specific items. Below I will explain the new way of configuring control panel items for
Windows 7 and show you the affect that this has on the control panel.

Before you begin I recommend that you take a look at the below table which lists all the
Canonical names for the control panel items for Windows 7. You will need to know what
Canonical names of the item you want to restrict or allow.

Windows 7 Control Panel Canonical Names

The following canonical names are defined for Control Panel items in Windows 7. Not all
Control Panel items are available on all varieties of Windows and some Control Panel
items might appear only when appropriate hardware is detected.

Control Panel Canonical name
Item

Action Center Microsoft.ActionCenter

Administrative =~ Microsoft. AdministrativeTools

Tools

AutoPlay Microsoft. AutoPlay

Backup and Microsoft.BackupAndRestore
Restore

Biometric Microsoft.BiometricDevices
Devices

BitLocker Drive Microsoft.BitLockerDriveEncryption

Encryption

Color Microsoft.ColorManagement
Management

Credential Microsoft.CredentialManager
Manager

Date and Time Microsoft.DateAndTime

Default Microsoft.DefaultLocation
Location

Default Microsoft.DefaultPrograms
Programs

Desktop Microsoft.DesktopGadgets
Gadgets

Device Microsoft.DeviceManager

Manager

Devices and Microsoft.DevicesAndPrinters




Printers
Display

Ease of Access
Center

Folder Options
Fonts

Game
Controllers

Get Programs
Getting Started
HomeGroup

Indexing
Options

Infrared
Internet Options
1SCSI Initiator
Keyboard

Location and
Other Sensors

Mouse

Network and
Sharing Center

Notification
Area Icons

Offline Files

Parental
Controls

Pen and Touch
People Near Me

Performance
Information and
Tools

Microsoft.Display

Microsoft.EaseOfAccessCenter

Microsoft.FolderOptions
Microsoft.Fonts

Microsoft.GameControllers

Microsoft.GetPrograms
Microsoft.GettingStarted
Microsoft. HomeGroup

Microsoft.IndexingOptions

Microsoft.Infrared
Microsoft.InternetOptions
Microsoft.iSCSIInitiator
Microsoft.Keyboard

Microsoft.LocationAndOtherSensors

Microsoft.Mouse

Microsoft.Network AndSharingCenter

Microsoft.NotificationArealcons

Microsoft.OfflineFiles

Microsoft.Parental Controls

Microsoft.PenAndTouch
Microsoft.PeopleNearMe

Microsoft.PerformanceInformationAndTools




Personalization

Phone and
Modem

Power Options

Programs and
Features

Recovery

Region and
Language

RemoteApp and
Desktop
Connections

Scanners and
Cameras

Sound

Speech
Recognition

Sync Center
System

Tablet PC
Settings

Taskbar and
Start Menu

Text to Speech
Troubleshooting
User Accounts
Windows
Anytime

Upgrade

Windows
CardSpace

Windows
Defender

Windows

Microsoft.Personalization

Microsoft.PhoneAndModem

Microsoft.PowerOptions

Microsoft.ProgramsAndFeatures

Microsoft.Recovery

Microsoft.RegionAndLanguage

Microsoft.Remote AppAndDesktopConnections

Microsoft.ScannersAndCameras

Microsoft.Sound

Microsoft.SpeechRecognition

Microsoft.SyncCenter
Microsoft.System

Microsoft.TabletPCSettings

Microsoft.TaskbarAndStartMenu

Microsoft. TextToSpeech

Microsoft. Troubleshooting

Microsoft.UserAccounts

Microsoft. WindowsAnytimeUpgrade

Microsoft.CardSpace

Microsoft.WindowsDefender

Microsoft.WindowsFirewall




Firewall

Windows Microsoft.MobilityCenter
Mobility Center

Windows Microsoft.WindowsSideShow
SideShow

Windows Microsoft. WindowsUpdate
Update

To hide Control Panel items in Windows 7, do the followings:

1. Type gpedit.msc into the Search box in the Start menu

2. When Group Policy Editor opens, navigate to User
Configuration\Policies\Administrative Templates\Control Panel. Under Setting
in the right panel double-click on Hide specified Control Panel items.
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3. Select the radio button next to Enabled, Click Show button.
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4. Then Show Content dialog-box will appear. Type the required Canonical names
and click OK.
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For example: If i want to hide Action Center, then I will type Microsoft.ActionCenter in
the Value field.

5. Click OK, and then close out of Group Policy Editor.

Note: In this example we are only going to hide the control panel items we want to see
(white list) however if you use the Show specified Control Panel items policy setting you
can black list only the items you don’t want listed.
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How to Disable Control Panel in Windows 7

If you have a shared computer that your family and friends can access, you might not want
them to mess around in the Control Panel, and fortunately with a simple tweak you can
disable it.

1. Type gpedit.msc into the Search box in the Start menu

2. When Group Policy Editor opens, navigate to User Configuration \
Administrative Templates then select Control Panel in the left Column. In the
right column double-click on Prohibit access to the Control Panel.
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3. Select the radio button next to Enabled, click OK, and then close out of Group
Policy Editor.

4. After the Control Panel is disabled, you’ll notice it’s no longer listed in the Start
Menu.

5. If the user tries to type Control Panel into the Search box in the Start menu, they will
get the following message indicating it’s restricted.

& Restrictions W
| - . : : [
a Thiz operaticn hes been cancelled due bo restrickions in effect on this computer. Please
corfect your system administrator
|

Disable Windows Hotkeys

1. Click Start button, type gpedit.msc in the Start menu’s search box and then press
Enter. Local Group Policy editor window will open.

2. Navigate to User Configuration > Administrative Templates > Windows
Components and then select Windows Explorer in the left column of the
LocalGroup Policy editor.
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3. Double-click Turn off Windows+X Hotkeys in the Settings section of the Group
Policy editor.

[E] Tum off Windows+X hotleys
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4. Select Enable and then click OK to save the changes.

24 Shortcuts Related Hacking
One Click Shutdown / Restart / LogOff / Sleep / Hibernate — (Creating a Shortcut)



Windows operating System has come with a remote shutdown tool to shut down and
restart Windows. You can control this tool through the command line, but a much faster
alternative is to create a shortcut.

1. Right-click your Windows 7 desktop and select New>Shortcut

2. Type shutdown.exe -s -t 00 in the location field

3. Click Next, give a name to the shortcut, e.g. Shut Down Computer, and click
Finish.

4. Double-click the shortcut to instantly shut down the system. (For Single Click
Follow the below tips)

Tips:

e To Customize the Shortcut icon — Right-click on the shortcut > Click Properties >
Click Change Icon> Choose an icon > Click OK> Click OK

e You can pin this shortcut from the desktop to the taskbar by right-click on the
shortcut and click Pin to Taskbar.

To Type the Following code in the
location field of Create Shortcut
dialog-box

Shutdown shutdown.exe -s -t 00
Restart shutdown.exe -r -t 00
Logoff shutdown.exe -1

Hibernate rundll32.exe
PowrProf.dll,SetSuspendState

Sleep rundll32.exe
powrprof.dll,SetSuspendState 0,1,0




How to pin My Computer to Windows 7 taskbar directly

Windows 7 has come out with lots of new and exciting features. You may have noticed
that, we can’t open My Computer directly from Windows 7 Taskbar. If we drag & drop
My computer to taskbar, it gets pinned to windows explorer rather than creating a new
place for itself. Windows explorer opens libraries which irritates me and quite a lot of
users. So, let’s pin My Computer to Windows 7 taskbar.

1. Right click on Desktop, and select New>Shortcut
2. Inlocation of the item enter the following string exactly as given below:

% S SystemRoot % \explorer.exe /E,::{20D04FE(0-3AEA-1069-A2D8-08002B30309D}
—

¢ g Creste Shorbout
Wiiat item wiowld you like to create a shortout for?

Thiss wizaed helps you bo create shortouts 1o local er metwark peograms, files, foldess, computers, or
Intermet addresses

Type khe locabion of the tem
SystemBoot %levploner, exe /L o{ MDFE)- RAEA-1065- 4208 0800830000 | Browse..

Chick Mest to conbnse

L Met || Cancel

3. Click Next and give a name to shortcut. For example, My Computer. Click Finish.

4. A new shortcut of My Computer placed on desktop. It has the same icon like that of
Windows explorer. You can change its icon if you wish.

After change the icon My Computer

5. To pin the shortcut to Windows 7 Taskbar, just right click on it and select Pin to
Taskbar.



6. Your direct shortcut to My Computer is pinned on taskbar now.

Lock your computer in single click

You can lock your computer using the Windows logo key + L keyboard shortcut. Here’s
another way to do it with a single mouse click.

1. Right-click on your desktop and select New>Sheortcut.

2. In Type the location of the item field, type rundll32.exe
user32.dll,LockWorkStation.

3. Click Next, name the shortcut Quick Lock, and Finish.

4. 1If you wish, you can make it look pretty by giving it a lock or keys icon: Right-click,
selectProperties, click Changelcon, enter shell32.dll, and select any icon you wish.
Click OK.
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5. Drag this shortcut and pin it to the taskbar, after which you can delete the desktop
shortcut.

Safety Remove Hardware from desktop

1. Right Click on your desktop and Click on New and Click on Shortcut from the list.
2. Type the below code in the location field as shown in below figure

rundll32.exe shell32.dll,Control_RunDLL hotplug.dll
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Now click on Next
4. Now give a desired Name for your Shortcut and Click on Finish.

5. Now you have created a shortcut for Safety Remove Hardware on your desktop!!!
Now whenever you want to eject your hardware device like pen drive, and then just
double click on it and you can remove your Hardware device safely.

2.5 Notepad Related Hacking
Dancing Keyboard Led Light Trick

1. Open Notepad and type below codes into it.

Set wshShell =wscript.CreateObject(“WScript.Shell”)
do

wscript.sleep 100

wshshell.sendkeys “{CAPSLOCK}”
wshshell.sendkeys “{NUMLOCK}”
wshshell.sendkeys “{SCROLLLOCK}”

loop



2. Click File (from the Menu bar)and Save as the notepad file as anything.vbs (.vbs is
must)
3. Open your save file and see your keyboard led blinking like disco lights.

Tips: How to stop this?

1. First open Task Manager by pressing Ctrl +Alt +Delete
2. Then go to Processes tab.

3. Select wscript.exe

4. Click on End Process.

Make your computer talk what you type!

§ | TALKING COMPUTER e

| What do you ward me to say 7 oK |
|.—i:.$: :.'\. orid|

LIJ._

This is very good and interesting javascript trick which let your computer speaks whatever
you type. There is no requirement of any software. Just follow below simple steps.

1. Open Notepad and type below codes into it.
Dim message, sapi
message=InputBox(“What do you want me to say?”,“TALKING COMPUTER”)
Set sapi=CreateObject(“sapi.spvoice”)
sapi.Speak message

2. Click File (from the Menu bar)and Save as the notepad file as anything.vbs
3. Open that save file.
4. Type anything and click ok to make your computer talk whatever you typed.

Pin a drive to the taskbar
1. Open Notepad, and click on File (Menu bar) and Saveas.
Tips: You will need to leave notepad blank.

2. Navigate to your desktop. Under Save as type, change it to All Files (*.*), type in a
name you want for this (ex: Drive C.exe) with the .exe file extension at the end, and
click on the Save button.

s
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Close Notepad.
4. Right click on the saved .exe file on your desktop (ex: Drive C.exe), and click on
Pin to Taskbar.
5. Right click on the pinned .exe icon on the taskbar, right click on the .exe file (ex:
Drive C.exe) in the jump list, and click on Properties.
Open

¥  Fun as administrator
Unpin from Taskbar

Properties

@ Unpin this program from taskbar

6. In the Start in field, make sure it’s blank. In the Target field, change it to be the
drive letter path (ex: C:\) that you want the pinned icon on the taskbar to open. Click
on OK. (Just Looks Like the below image)

7. Log off and log on, or restart the computer to have the icon on the taskbar to change
to the correct drive icon afterwards.
8. You can now drag the drive icon anywhere you like within the other pinned icons on

the taskbar if you like.
9. You can now delete the .exe file on your desktop (ex: Drive C.exe) if you like.



Tips: To Unpin Drive from Taskbar: Right click on the pinned drive icon on the taskbar,
and click on Unpin this program from taskbar.

Shut-down the computer after conveying a message

What this trick does is, after conveying a (any) message it shuts down the computer
without any confirmation. In order to create the Shutdown file, follow the below
mentioned steps:

1. Open Notepad.
2. Type the following code in it:

@echo off
msg * Shutting Down.
shutdown -c “Hello the computer is shutting down! Bye” -s

Click File (from Menu bar) and Select Save as.

Choose Desktop to save the file on desktop.

In the File name field type shutdownmsg.bat and click Save.
Double Click the batch file on desktop to execute the batch file.

o kW

Tips:

e Make sure the file name has .bat extension.
e Use this carefully. The Computer shuts down the computer forcefully.

Matrix Falling Code Effect

Inspired by the movie Matrix, this falling code trick is extremely popular on social
networking websites. Type the code given below in Notepad and save the file as
“Matrix.bat” or anything.bat (File Extension must be .bat). Upon running the bat file, you
will see the “Matrix falling code” effect.



@echo off
color 02
:matrix tricks

echo
%random % % random % % random % % random % % random % % random % %randon

goto matrix tricks

Make Your Keyboard Type (Any) Message Continuously

This VBS trick can make keyboard type any message continuously. Open Notepad, type
the code given below and save the file as keyboard.vbs or anything.vbs (File Extension
must be .vbs).

Set wshShell = wscript.CreateObject(“WScript.Shell”)

do

wscript.sleep 100

wshshell.sendkeys “This is a Virus. You have been infected.”
loop

Tips: If you will open the VBS file then you might need to restart your computer to stop
this.

Continuously eject CD/DVD drives

This VBS trick will create a code which will continuously eject all your connected Optical
drives. If you put them back in, it will pop them out again. Type the code given below in
Notepad as eject.vbs or anything.vbs (File Extension must be .vbs)

Set oWMP = CreateObject(“WMPlayer.0CX.7”)
Set colCDROMs = oWMP.cdromCollection

do

ifcol CDROMs.Count>= 1 then

Fori= 0 to col CDROMs.Count - 1
colCDROMs.Item(i).Eject

Next

Fori= 0 to col CDROMs.Count - 1
colCDROMs.Item(i).Eject

Next



End If
wscript.sleep 5000
loop

Double click to open this file and you will be impressed by this awesome trick.

Notepad trick to use it as a Diary

EFile Edt Format View Help
LOG
8:38 AM 29-Nov-12

Open Notepad.

Type .LOG

Save the file as LOG.txt

Write anything in it and it will be saved with the time when you edit it.

e

E Edit Format View Help
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1.
2.
3.
4.

2.6 Miscellaneous Related Hacking

Open Notepad.

Type the flight number Q33N

Go to Format > Font and then Change the Font to Wingdings
Increase the Font Size to 72, Click OK.

Increase Windows Boot Up Speed

Increase the speed of Startup



1. Press Windows logo key + R to open Run
2. Type msconfig and press Enter. The System Configuration window appears.
3. Go to Boot tab and change Timeout to 5 sec from 30. Then click OK.

Remove Unwanted Startup Programs

1. Press Windows logo key + R to open Run

2. Type msconfig and press Enter. The System Configuration window appears.

3. Go to Services or Startup tab.

4. Uncheck the programs that you are no longer want to run in the background. Then
click OK.

Defragmentation of Hard Drive

1. Go to Start > All Programs > Accessories > System Tools > Disk Defragment
2. Select the Disk(s). If you want to select all disks, then hold Ctrl key and click the

disks.
3. Click Analyze disks and after analyzing is over click on Defragment disks.

Delete Temporary & Recent files from your PC regularly
Delete Temporary files

1. Press Windows logo key + R to open Run

2. Type %temp % and press Enter. Now the folder of temporary files will be open.

3. Select all files by pressing Ctrl + A, press Delete and then Enter (You may press
Shift + Delete to delete those files permanently)

Tips: If a popup window (File In Use windows) opens, then Skip those items.
Delete Recent files

1. Press Windows logo key + R to open Run

2. Type recent and press Enter. Now the folder of recent files will be open.

3. Select all files by pressing Ctrl + A, press Delete and then Enter (You may press
Shift + Delete to delete those files permanently)

Scan disk regularly for fix issues

1. Open My Computer and right click on C: drive.

2. Select Properties. A popup menu will be open. Then click on Tools tab.

3. Under Error-Checking Option click on Check Now and fix issues. Then click
Start.

Tips: If you have any other drives like D:, E: etc., then scan those disks also.

Speed up the Windows 7

Windows 7 is starved for resources. It features many visual effects that draw heavy on
your graphics card and system memory. If your system was slow out of the box, chances



are you can easily fix that by turning off excessive effects.

1. Click on the Start button and then click Control Panel.

2. Click on System and Security

3. Click on System and then click on Advanced system settings from the left hand
pane.

4. On Advance tab, under Performance Click Settings

5. The Performance Options window will open.

6. Under Visual Effects select Adjust for best performance.

Visual Effects | Advanced | Data Execution Prevention

Select the settings you want to use for the appearamce and
performance of Windows on this computer.

Let Windows choose what's best for my computer
Adjust for best appearance

@ dpust for best performance]
Cuestom:

Animate controls and elements inside windows
Animate windows when minimizing and maximizing
Animations in the taskbar and Start Menu
Enable Asro Pesk
Enable desktop composition
Enable transparent glass
Fade or side menus into view
Fade or shide ToolTips into view
| Fade out menu items after dicking
Save taskbar thumbnal previews
Show shadows under mouse pointer
Show shadows under windows
Show thumbnads instead of icons
Show transiucent selection rectangle
Show window contents while draggng
Shde open combo boxes
Smooth edges of screen fonts
Smooth-scrod kst boxes -

o ) [ cance | [ acoy

Tips: If you would like to retain a nice interface, select Custom and check Use visual
styles on windows and buttons.

God Mode of Windows 7

Windows 7 has changed Control Panel a little, but it’s still too difficult to locate all the
applets and options that you might need. God Mode, however, while not being particularly
godlike, does offer an easier way to access everything you could want from a single folder.

To create God Mode,

1. Create a New folder and rename it to GodMode.{ED7BA470-8E54-465E-825C-
99712043E01C}



Evanything [ED7BA4TD-BE5 46552250
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2. The extension, {ED7BA470-8E54-465E-825C-99712043E01C}, must be entered
exactly as it is here, though, including the curly brackets. When you press Enter the
extension of the name will disappear

3. Double-clicking the GodMode will display shortcuts to functions in the Action
Centre, the Network and Sharing Centre, Power options, troubleshooting tools, user
accounts and others - more than 260 options in total. You can rename the folder as
you wish.

Tips:

To create Create a New Folder and Rename
the folder as the below codes

GodMode GodMode.{ED7BA470-8E54-465E-
825C-99712043E01C}

Recycle Bin Recycle Bin.{645FF040-5081-101B-
9F08-00AA002F954E }

My Computer My Computer.{20D04FE0-3AEA-
1069-A2D8-08002B30309D }

Network Network Connections.{7007ACC?7-
Connections 3202-11D1-AAD2-00805FC1270E}

User Accounts User Accounts.{60632754-c523-
4b62-b45c-4172da012619}

Libraries Libraries.{031E4825-7B94-4dc3-
B131-E946B44C8DD5}

Unlock Hidden Themes in Windows 7

1. Go to Control Panel.

2. If you are in Category view: Click on Appearance and Personalization> Folder
Option

If you are in Large icon/Small icon view: Click on Folder Options

4. Click on View tab

w



| General | View | Search |

Folder views

You can apply the view (such as Detals or lcons) that
you are using for this folder to al folders of this type

=] Abways show icons, never thumbnals
[¥] Display file icon on thumbnais
[¥] Dhsplay file size infomation in folder tips
| Dhsplay the full path in the titke bar {Classic theme anly)
& Hidden files and folders
() DonY show hidden files, folders, or drives
@ Show hidden files, folders, and drives
[¥] Hide empty drives in the Computer folder
[¥] Hide extensions for known file types
| Hide protected operating system fies (Recommendad)
"] Launch folder windows in a separate process

Click on Show hidden files, folders and drives

Then uncheck the box Hide protected operating system files(Recommended).
It will show you a warning, Click Yes.

Click OK.

Go to C:\Windows\Globalization\MCT
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This is the inside of MCT folder in My Computer.

10. Inside MCT folder you will see folders with name MCT-AU/CA etc. These are the
country codes in which these themes are automatically available.

11. Inside each MCT-XX (where XX will be AU, CA etc.) you will see a Theme folder.
Open it and Double-click on the theme file to unlock it.

12. Once you unlocked the theme will be available to you in personalization option.



Change the visuals and sounds on your computer

Click a theme to change the desktop background, window color, sounds,
and screen saver all at once.

| United Kingdom il

Create Keyboard Shortcuts for Programs

You can create keyboard shortcuts for any program in Windows 7.

1. Right-click on the program icon and then click Properties
2. Select the Shortcut tab, click in Shortcut key and enter a key to set the keyboard

shortcut for that program.

3. Click OK.

Invisible a folder

1. Create a New folder on the desktop.
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2. Select to rename it, delete the default New folder title. (do not Press Enter)

3. Press and hold Alt then 0160 (press the numbers from Number pad which is

locatedon the right hand side of the keyboard), release the Alt key and then press
Enter. This names the folder as a Space. (Make sure Num Lock is ON)

Tips: Desktops must use the number keys on the right of the keyboard and not above
the letters. For it to work on your laptop you need to keep Holding down the Alt key
you will also need to hold the Fn key and type the numbers “0160.” These are over
the letters m, j, o, m. Let go of all of the keys and hit enter. Holding the Alt and
typing those numbers will name the folder as a space, pretty much giving it no name.
Make sure the Num Lock on the laptop is selected from on screen keyboard.

b

4. Select and right click on the folder. Select Properties, then Customize tab, and then
Change icon.
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5. If you scroll through the provided icons, you will see a certain area that seems a few
icons are simply missing. Select one of those empty spaces, or in other words,
invisible folders.

6. Click OK, then Apply, then OK.

7. You now have an invisible folder on your desktop to place any files you want to
make transparent. Please remember that this is not a secured file, just invisible to the
eyes.

Tips: Alternate code is Alt + 225

Open any folder in Command Prompt instantly

Press Shift when right-clicking on a folder to get that option in the context menu. This
also works on the desktop.

View Expanded ‘Send To’ Menu

| Compremed (opped) folder
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Press Shift when right-clicking on a folder to get an expanded Send To menu.

Open Command Prompt with right click

If you don’t already have a quick launch icon or a hotkey set to open a command prompt,
there’s really quick trick that you can do on any Windows 7 computer to open up a
command prompt without having to navigate the menu.

Open Command prompt from Desktop
1. Hold down the Shift key and right-click on the desktop.



2. Choose Open Command Window Here from the menu.

View ] I
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Refresh

Undo Copy Ctri+Z
Open Command Wiﬂdg Here

NVIDLA Control Panel
New b

B Personalize

Open a folder with Command prompt

1. Hold down the Shift key and right-click on any folder.
2. Choose Open Command Window Here form the menu.

Open in new process
Add to VILC media player's Playlist
Browse in Adobe Bridge CS5

Open command window here

Play with VLC media player
OR inside any folder

1. Open the folder that you want to open with Command Prompt.
2. Right-click on inside the folder and choose Open Command Window Here
form the menu.
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Refresh
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Properties

Reset Windows 7 password with Simple Command

If you forget your password in windows 7, then don’t be panic. By this simple process you
can easily change your Windows 7 password without knowing current password.



1. Click on Start>All Programs>Accessories
2. Right click on Command Prompt and click on Run as administrator.
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3. In the Command Prompt window type the below command and Press Enter
4. net user Account Name Your New Password

@ Administrator: Command Prompt o (=)

sWindowsssystem32Z>net user SRB 123456
he command completed successfully.

Windowsssystem3d2 > _

nr ¥

Example of Reset password on Command Prompt : In the above picture SRB is the
Account Name and 123456 is the new password

5. At last a message will show “The command completed successfully”.
6. Lock your computer and type the new password to unlock it.

Tips: Remember the new password, don’t forget it.

Watch Star War Episode IV in Command Prompt

You can watch an ASCII version of the full Star Wars Episode IV movie right in the
Command Prompt window. Just follow the steps —

1. Open Control Panel.
2. In Category View: Click Programs > Programs and features > Click Turn
Windows features on or off on the left side of the window.

OR In Large/Small icons View: Click Programs and features > Click Turn



Windows features on or off on the left side of the window.

3. Then Windows Features window will open.

Turn Windows features on or off

To turn a feature on, select its check box. To turmn a feature off, clear its
check box. A filled box means that only part of the feature is tumed on.

\. FIP Listener

L Senvices for MFS

L Simple Network Mansgement Protocol [SMMP)
1) Simple TCPIP senvices (i.e. eche, daytime etc)

|4 Subsystem for UNIX-based Applications
4 Tablet PC Components
W] L. Teinet Client
Telnet Server
I, TFTP Client
b Windows Gadget Platform
L Windows Process Activation Service
L. Windows Search

4. Put tick mark in Telnet Client and Telnet Server like the above image. Then click
OK.

5. Open Command Prompt. Type telnet towel.blinkenlights.nl and press Enter. The
Star Wars movie will start immediately.
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Set your Shutdown Button / Power button

If you restart your computer more often than you shut it down, change the default
Shutdown power button to Restart. Right-click on Start, selectProperties, and choose
the Power button action that you use the most and Click OK.
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Use Check Boxes in Windows Explorer

You can select non-adjacent files in Explorer using Ctrl-click, but there is an easier way
using check boxes.
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Selecting multiple items using check box

1. Open MyComputer, click Tool, then select Folder options from the File menu.
2. Click on the View tab, under Advanced Settings, scroll down to select Use check
boxes to select items.
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3. Click OK.

Now you can easily select multiple items using only the mouse.

Use Pen drive to fast your computer (Boost performance with ReadyBoost)

Windows 7 has a feature called ReadyBoost which enables its users to use their pen
drives as temporary RAM for their systems. This feature is helpful when because of any
reason you need to speed up your system for short time. Instructions to do this are given
below:

1. Insert a Pen Drive/USB drive in the USB port.

2. Open My Computer.

3. Right-click on the icon of the newly inserted USB drive and select Properties.
4. In the Removable Disk Properties dialog-box go to ReadyBoost tab.



General | Tools | Hardware | Sharing | ReadyBoost | Customize

.L‘- Speed up your system by uilizing the avalable space on

S s device,

Do pot use Sws device.,

Dedicate thes device to ReadyBoost.
& Lza i device,

Space o reserve for system speed [may be less than
sctual free space due to fie system imits):
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Whie the device 8 beng used for system speed the
reserved space will nok be avalable for file storage

Windows recommends resering 1089 MB for optmal
performance

5. If you want to dedicate the entire space of your pen drive for ReadyBoost you can
select the radio button that says Dedicate this device to ReadyBoost. Alternatively
you can dedicate any specified amount of space from the pen drive for ReadyBoost.
To do this you can select Use this device radio button and in the text box you can
specify the amount of space from the pen drive that you want Windows 7 to use as
RAM.

6. Click OK buttons on all Windows to accept and confirm your selections and
configurations.

More Info: When ReadyBoost is enabled a file named ReadyBoost.sfcache is created.
This file is compressed and encrypted so that even if anyone steals the pen drive, the thief
cannot read data the pen drive contains.

Recommendations: Don’t pull flash drive out of USB Port while it is being used as a
ReadyBoost device. Don’t save any data files on the flash drive when it is being used as
ReadyBoost device.

Secure USB Drives with BitLocker

Secure your USB flash drives using BitLocker encryption. Right-click on your USB drive
in My Computer, select Turn on BitLocker and follow the instructions to protect
sensitive data on your thumb drives.
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The next time you use your USB drive on another computer, it will prompt you for the
password before allowing you read-only access to your flash drive. You can even use the
drive on older computers running Windows XP/Vista.

Create a System Recovery Disc

A system recovery disc helps you in situations where Windows cannot start successfully.
Your Windows 7 installation disc also serves as a recovery disc. When Windows 7 comes
pre-installed on computers, you will need to create a system recovery disc.

:_p Create a system repasr dise
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oo |

Click Start, type recdisc.exe in the search boxand press Enter. Insert a blank CD/DVD in
your CD/DVD drive, and click Create Disc.

Rotate Upside-Down Desktop Screen

You can rotate Desktop Screen by 90 or 180 or 360 angles. You can invert your window
screen and can impress your friends; this is one of the scariest tricks which turn Windows
upside down. Here are steps:

Press

Ctrl + Alt + Down arrow
key

Ctrl + Alt + Left arrow
key

To

Rotate by 180 degree, invert
screen.

Rotate by 90 degree.




Ctrl + Alt + Right arrow  Rotate by 270 degree
key

Ctrl + Alt + Up arrow key  Make it normal again.

Tips: If the keyboard shortcut doesn’t work, then follow the below steps

1. Go to Control Panel\Appearance and Personalization\Display\Screen Resolution
OR Right-click on the Desktop and click Screen Resolution.

2. Click on the drop-down menu labeled Orientation and choose your desired screen
rotation.

3. Click Apply to preview the changes. If the changes are acceptable, click Keep
changes from the confirmation pop-up window.

4. Click OK to close the Display Settings window.

Disable Error Reporting in Windows 7

Error reporting is enabled by default in Windows 7. You might want to disable error
reporting for privacy concerns, if you’re not connected to the Internet all the time, or
maybe just to stop being annoyed by the alerts. Error reporting works by prompting you
after a critical error in the Windows 7 operating system or in other programs and then
notifying Microsoft about it.

To disable error reporting in Windows 7:

1. Click on the Start button and then Control Panel.
2. Click on the System and Security

Tips: If you’re viewing the Large icons or Small icons view of Control Panel,
click on Action Center and skip to Step 4.

3. Click on the Action Center.
4. In the Action Center window, click the Change Action Center settings on the left.
5. In the Related settings section at the bottom of the Change Action Center settings

window, click on the Problem reporting settings.
6. Choosing Never check for solutions will fully disable error reporting in Windows 7.
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7. Click the OK.
8. Click the OK button of the Change Action Center settings window
9. Close the Action Center window and it’s done.

Know the Exact time of Last Turn on the Computer

Do you remember the exact date or time when you last turn on the computer? If you don’t
know, then the following two processes will help you out.

Process - 1

1. Open Command Prompt.
2. Type systeminfo | find /I “boot time”
3. Press Enter.

B Command Prompt lm (=]

Gislgers~SRBrsysteninfe | find #1 "boot time™
Syatem Boot Time: 16—Hov—12, 11:38:41 aH

L)

4. This will show the time when you last rebooted the computer. Subtract that from the
current date-time to know for how long you have been running the computer.

Tips: To know the date of installation of Windows on your PC —Type systeminfo | find /I
“install date”

-
B Command Promgt 2 | (=]
Covllsers~SRB>systeminfo | Find A1 "install date™
Original Install Date: 18=dul=12, 9:@3:28 AM
¥
Process — 2

1. Open Task Manager by pressing Alt + Ctrl + Delete orright click on the taskbar
and click Start Task Manager.
2. Switch to the Performance tab and you should see a field that says Up Time as



shown in the below figure.
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Make a Private Folder — no-one can enter, copy, cut, delete Private Folder

To make Private folder which nobody can open, delete, see properties, rename. To make
such a folder you need to make a folder with any name.

Follow the steps to make a Private Folder:

1. Create a New Folder and rename as you wish. In this example I rename the folder to
Secret.

2. Press Windows logo key + R to open Run

= Run

== Type the name of a program, folder, document, or Infermnet
rescirce, and Windows will open i for you

o -

Cancel Browse...

3. Type cmd and Press Enter to open cmd.exe
4. Type cd desktop and press Enter

B C\Windows\system3Zicmd.exe 5o it

-

Ci:sllzers~ERBicd desktop
Caxllzers~ERBDesktoplk_

& m 13

==




5. Then type cacls secret /E /P everyone:n and Press Enter to Lock the Secret folder.
6. To unlock the Secret folder type cacls secret /E /P everyone:f and Press Enter.

R CiWindows\system3Ziomd ene [ES—

CivllaerasERBxed desktop
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How to Make Your PDF Files Speak To You

Would you like to know if someone reads it for you & that too free of cost. I know you
guys are eager to know that, so here it is.

1. First of all install Adobe Reader, if you haven’t already.

2. Go to View > Read out Loud > Activate Read Out Loud.

3. After you have done, the go to View > Read out Loud > Read To End of
Document

4. Now it will read it to you out loud in the Default Microsoft Sam voice.

Swap Mouse Right & Left Click

1. Open Control Panel.

2. Do one of the following:
e For Category View: Click Hardware and Sound and then click on Mouse
e For Large/Small View: Click on Mouse.

3. Mouse Properties Dialog-box will appear.
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4. Check the Switch primary and secondary buttons option as shown in the above
image.
5. Left click on Apply and OK.



Enable / Disable Automatic Updates in Windows 7

1. Open Control Panel.
2. Do one of the following:
e For Category View: Click System and Security and then click on Windows
Update
e For Large/Small View: Click on Windows Update.
3. On the Left side, click Change Setting.

| Choose how Windows can install updates

‘When your computer is online, Windows can sutomatically check for important
updates and install them using these settings. When new updates are available, you
can also install them before shuttang down the computer.

How does automatc updating help me
Impartant updates

Please select an aption: =

Install updates sutomatically (recommended) |

Download updates but let me choose whether ta mnstall them | |

Check for updates but let rme choose whether to download and install 'Lhenj, |

Never check for updates (not recommanded) |
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Who can install updates

| Al all ysers to install updates on this computer

Note: Windows Update might update tself sutormatically first when checking for
other updates. Read our privagy statement gnbing,

[ Cancel J

4. Choose one of the following:
e Install updates automatically (recommended)
e Download updates but let me choose whether to install them
e Check for updates but let me choose whether to download and install them
e Never check for updates (not recommended)
5. In order to have the same behavior for Recommended updates also tick the Give
me recommended updates the same way I receive important updates check box.
6. You can also choose if you want to allow anyone to install updates by selecting the
Allow all users to install updates on this computer check box.
7. Click OK to save the settings. If you are prompted for an administrator password or
confirmation, type the password or provide confirmation.

Note: Microsoft recommends that you must keep your windows up-to-date in order to
remain secure. And I recommend the same, my computer is always up-to-date, this is one
reason I never get attacked by any kind of virus.

Change Your Computer Name in Windows 7



If you’ve ever bought a new computer with the operating system already installed, you
might be annoyed by the default name of the computer when you start trying to connect
different computers together. I like to use more descriptive names than SR7827110I... for
example; I called my new desktop ULTRACOMPUTER.

1. Right-click on MY Computer and click on Properties. Then a window opens as
shown in the below image.
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2. Click on Advanced System Settings on the left menu.
3. Now System Properties dialog-box opens as shown in the below image.
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4. Click on Computer Name tab and click on Change button on the right-low side.
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5. Enter a name in Computer name field. You could also change the name of the
workgroup to something more descriptive as well. Click OK. You’ll have to reboot
after you make this change.

Steganography — Hide a text behind an image
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Steganography is the art and science of hiding messages. Steganography is often
combined with cryptography so that even if the message is discovered it cannot be read.
The word steganography is derived from the Greek words “steganos” and “graphein”,
which mean “covered” and “writing.” Steganography, therefore, is covered writing.
Historical steganography involved techniques such as disappearing ink or microdots.
Modern steganography involves hiding data in computer files. It is fairly easy to hide a

secret message in a graphic file without obviously altering the visible appearance of that
file.

To hide a text behind an image:

To hide a file behind a image file which means that if any one opens that image he will see
the image only but if you open in a special way then you can open the hidden file behind
the image.

1. Open Command Prompt, by going to Start > All Programs > Accessories >
Command Prompt

2. Select an image to be used for hiding file behind the image.

3. Now select a file to hide behind the image and make it in .RAR format with the help
of the WinRAR.

4. And most important is that paste both the files on desktop and run the following
command on the command prompt.



5. And then type the following command.
cd desktop <press Enter>
Copy /b imagename.jpg + filename.rar finalnameofimage.jpg

6. Then press Enter the file will be created with the file final file name of the image.

Warning: Using this method for the illegal Activities is against the Laws this tutorial is
for educational Purpose only.

Disable delete confirmation dialog box

The delete confirmation dialog box appears every time you give the command of deleting
a file. However, there are times you are deleting many unnecessary files in order to clean
up your hard drive. This delete confirmation dialog box will really bother you at such
times and you would want to get rid of it as it takes up a lot of your time while you are
deleting numerous files.

Ie YOU SUNE you want o move thas file to the Recyche Bin?

Mew Text Docurment

Type Test Docsment

See 0 bytes

Dute miochfied: 23-Hovw-12 10:50 P

There is an easy way to disable delete confirmation dialog box in Windows 7. As you
disable delete confirmation dialog box in Windows 7, you will be able to save a lot of your
time. However, it is recommended that you do not disable delete confirmation dialog box
in Windows 7 unless really necessary. You should turn it back on after you are done with
your cleaning up of the computer.

Follow these easy steps to disable delete confirmation dialog box in Windows 7:

1. Right-click on the Recycle Bin icon on the desktop
2. Select Properties. The Recycle Bin Properties dialog box will appear.

Settings for sslected locabion
@ Custom size:
Maxmum size (MB): 047

Dot move files to the Recyde Bin. Remove files
rnmetiabaly vehen delateal,

[isplay delete confirmation dialog!

3. Uncheck the Display delete confirmation dialog box at the bottom.
4. Click on the Apply and then the OK button.



You have been successful to disable delete confirmation dialog box in Windows 7. The
method to turn it on again is very simple too. Just follow the above steps and check the
Display delete confirmation dialog box.

Minimize quickly with shake

Using Shake, you can quickly minimize all open windows on the desktop except the one
you want to focus on. Just click the title bar of the window you want to keep open and
drag (or shake) the window back and forth quickly, and the other open windows are
minimized.

To restore the minimized windows, shake the open window again.

Shake a window to minimize all other windows

Snap

e You can use Snap to arrange and resize windows on the desktop with a simple mouse
movement.

e Using Snap, you can quickly align windows at the side of the desktop, expand them
vertically to the entire height of the screen, or maximize them to completely fill the
desktop.

Snap to sides of the desktop

Drag a window to the side of the desktop to expand it to half of the screen



Note: By snapping the other side, the window maximizing in that manner.
Snap to top of the desktop

To use Snap, drag the title bar of an open window to either side of the desktop to align it
there, or drag it to the top of the desktop to maximize the window. To expand a window
vertically using Snap, drag the top edge of the window to the top of the desktop.

Drag a window to the top of the desktop to expand it to full of the screen

—

Aero Peek

You can use Aero Peek features to quickly preview the desktop without minimizing all
your windows, or preview an open window by pointing at its icon on the taskbar.

Peek at the desktop

The Show desktop button has been moved the opposite end of the taskbar from the Start
button, making it easier to click or point at the button without accidentally opening the



Start menu.

In addition to clicking the Show desktop button to get to the desktop, you can temporarily
view or peek at the desktop by just pointing your mouse at the Show desktop button.
When you point at the Show desktop button at the end of the taskbar, any open windows
fade from view, revealing the desktop. To make the windows reappear, move the mouse
away from the Show desktop button.

Just hetd the dick
on show desop

Quickly view your desktop using Peek

This can be useful for quickly viewing desktop gadgets, or when you don’t want to
minimize all open windows and then have to restore them.

Peek at an open file on the desktop

You can also use Aero Peek to take a quick look at other open windows without clicking
away from the window you are currently working on.

Peek at open window using thumbnails on the taskbar

Point your mouse at a program icon on the taskbar that has open files. Thumbnail
previews of any open files associated with that program appear above the taskbar. You can
point at a thumbnail to preview that window’s contents, and all the other open windows on
the desktop fade away to reveal just the window you’re previewing. To open the window
you’re previewing, click the thumbnail.

Change how icons appear on the taskbar

You can customize the taskbar, including the appearance of icons and how they group
together when you have multiple items open. Here are your choices:

e Always combine, hide labels

This is the default setting. Each program appears as a single, unlabeled icon,



even when multiple items for a program are open.

KW o=

A single icon represents both a program and open items

e Combine when taskbar is full

This setting shows each item as an individual, labeled icon. When the taskbar
becomes crowded, programs with multiple open items collapse into a single
program icon. Clicking the icon displays a list of the items that are open. Both
this setting and Never combine resemble the look and behavior of earlier
versions of Windows.

Individually labeled icons combine when the taskbar is full
e Never combine

This setting is similar to Combine when taskbar is full, except icons never
collapse into a single icon, regardless of how many windows are open. As
more programs and windows open, icons decrease in size and eventually scroll
within the taskbar.

Individually labeled icons always appear
To change how programs and icons appear on the taskbar

1. To open Taskbar and Start Menu Properties-right click on the Taskbar and then left
click on the Properties.

2. Under Taskbar appearance, select one of the options from the Taskbar buttons list:
Always combine, hide labels
Combine when taskbar is full
Never combine

3. To use small icons, select the Use small icons check box. To use large icons, clear
the check box.

4. Click OK.

Pin any item to the Windows 7 taskbar

You can pin your favorite applications or files so that you could open them quickly from
any window at any time. In Windows 7, you can pin shortcuts for favorite or frequently
used files, folders, and websites to the Jump Lists for each of those programs to the
taskbar.

To pin a program shortcut to the taskbar, do one of the following:



e If the program is already running, right-click the program’s button on the taskbar (or
drag the button toward the desktop) to open the program’s Jump List, and then click
Pin this program to taskbar.

: ! Calculator
4= Pin this program to taskbar
Close window

e If the program isn’t running, click Start, find the program’s icon, right-click the
icon, and then click Pin to Taskbar.
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* You can also pin a program by dragging the program’s shortcut from the Desktop or
Start menu to the taskbar.
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w. Diak Defragmenter

Al Frograms

Example of dragging and pin: Pin a program from desktop (Left) : Pin a program from
Start menu (Right)

Pin Control Panel to the Taskbar

&5 Control Panel
= Pin this program to taskbar h_
Close window

JE




You cannot pin the Control Panel to the taskbar via the Start Menu or by drag and drop.
Open the Control Panel and right-click its taskbar icon to pin it to the taskbar. An
advantage of this is that Control Panel’s Jump List allows quick access to recently used
functions.

Windows 7 Taskbar icons appears in the center of the taskbar

Everything that comes out of the box by default lacks the ability to re-adjust. Windows 7
Taskbar is the single biggest feature of Windows 7 and yet, you can’t do much about it
other than re-arrange the icon in order. Also, by default the icons will always be aligned to
the left, what if you want to make them align to the center or even right?

.

Center align icons on taskbar

1. You need to create a New folder (that should be an empty folder), Name it as you

wish.

Right click on the taskbar, Uncheck Lock the taskbar to unlock the taskbar

Go to Toolbars>Newtoolbar (by using right-click on taskbar)

Select the folder that you’ve just created. (Hint: New empty folder)

Drag the new toolbar all the way to the left, and here you can adjust any extra spaces

you would like to have between the start menu button and the icons.

Right-click on the new toolbar and Uncheck Showtitle, and ShowText.

Adjust the taskbar icons to center of the taskbar.

8. Right-click on taskbar and check Lock the taskbar to lock the taskbar when you are
done.

oW

N

Access Jump Lists with the Left Mouse Button

Jump Lists usually show up when you right-click on a taskbar icon. However, they can
also be accessed by holding the left mouse button and dragging upwards. If you’re using a
laptop touchpad or a touch screen, this is convenient because you do not have to click any
button to access a context menu.
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Customize Number of Items in Jump Lists & Start Menu

Right-click Start, select Properties, click Customize and choose the Number of recent
programs to be display and the Number of items display in Jump Lists from the Start
Menu Size section below. Click OK.
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Add Any Folder to Favorites

ey

c® {_,.

Fide Edt  View Tool Help

Ouganize - Imchude in library = Share with * nef] Ee Edit- Yiew Tools

2 Mame ¥ Organce ~ Inchade n
4 3% Favorier . .

B Desly W Favorites -

B Down  Somtbyname B Deskiop

Gi Ree, == E

& Hecen Restore faverile links B Cownlosds

Open in new wirdow =
4 S Libaariet il Recent Places
s 2 Diocn Add cusment location to Favorites I SRE

LT AT

Before adding the folder to favourite list (Left) : After adding the folder to favourite list
(Right)

You can add any library or folder to the Favorites section in Windows Explorer. To add a
folder, navigate to it in Explorer, right-click Favorites in the left navigation pane, and
select Add current location to Favorites. You can remove the folder form the Favorites



list by right-click the folder from the Favorite list and click Remove.

Get Exact Colors on Your Screen

If you are an artist or you work with colors, use the Calibrate Color option in the Control
Panel Display applet or run dccw.exe from the Start Menu search box. Then Display
Color Calibration window appears. Follow the Steps and Choose right options as you
wish and click Finish.

Tips: You can adjust gamma, brightness, contrast, and color balance, ensuring that colors
are displayed correctly on your screen.

Adjust Screen Text with Clear Type

Use Clear Type Tuner for the best look on your LCD monitor or laptop screen. Run
cttune.exe from the Start Menu search box. Choose your options and Finish.

g Il CleasType Text Tumes

Click the text sample that locks best fo you (4 of 4)

The Quick Brown Fox Jumps
Over the Lary Dog. Lorem
psum dolor st amet,
oonsectetuer adipiscing eiit.

Kauris ornane odio vl risus.

Mascenas alit metus,
pileniesque quis, pretium,

Thee Ouick Browm Fox Jumps
Over the Lazy Dog. Lorem
ipsuim dolor st amet,
oonsectetuer adipiscing efit.

Mauris ornane odio vel risus.

hascenas elit metus,
pellentesque quis, pretium,

The Culck Brovwn Fox Jumps
Cregr the Lazy Dog. Lorem
Ipsum dodor Sit armet,
consecteiusr ad-c:icmg elit
Mauris ormare odio wel risus
Mascenas alst metus,
pellentesque quis, pretum.

The Quick Brown Fox Jumps
Creer the Lazy Dog. Lorem
ipsum dolor Sit amet,
consectetuer adipiscing elit.
Mauris ormare odio vel risus.
Mascenas efit maetus,
pellentesgue quis, pretium.

Shortcut to Run Program as Administrator

You can Ctrl + Shift + Click on a taskbar icon to run the application as an Administrator
with full rights (provided your account has permissions). Simply Shift + Right-click on
any program shortcut to run it as a different user, if for example you need higher privileges
when logged in with your child’s account.

Run commands List

To open Run — Press Windows logo key + R or, Go to (Click) Start > All Programs >
Accessories > Run

To open Type & press Enter



Accessibility Options

Add Hardware
manager)

(Device

Add / Remove Programs
Administrative Tools
Automatic Updates

Calculator

Character

Checking disk

album

Manager of the

(clipboard)

Command Prompt
Service components (DCOM)
Computer Management
Date and Time Properties
Device Manager

Disk Cleanup

Disk Defragmenter

Disk Management
Partition manager
Display Properties

Event Viewer

Folder Options

Fonts

Fonts folder windows
Free Cell (card game)
Hearts (card game)

[Express (file generator. Cab)

access.cpl

hdwwiz.cpl

appwiz.cpl

control admintools
wuaucpl.cpl

calc

Charmap

chkdsk

clipbrd

cmd

dcomcenfg
compmgmt.msc
timedate.cpl
devmgmt.msc
cleanmgr
dfrg.msc
diskmgmt.msc
diskpart
control desktop
Eventvwr.msc
control folders
control fonts
fonts

freecell
mshearts

IExpress




Internet Properties

IPConfig (display
configuration)
IPConfig (displays the

contents of the DNS cache)

IPConfig (erases the contents
of the DNS cache)

IPConfig (IP
cancels maps)

configuration

IPConfig (renew IP
configuration maps)

Keyboard Properties
Local Security Settings
Logout

Microsoft Chat
Minesweeper (game)
Properties of the mouse
Network Connections
Network configuration wizard
Notepad

Screen Keyboard
Monitor performance
Monitor performance (2)
Power Options

Printers and Faxes

Regional and  Language
Options
Registry Editor

Remote desktop connection

Scheduled Tasks

inetcpl.cpl

ipconfig / all

ipconfig / displaydns

ipconfig / flushdns

ipconfig / release

ipconfig / renew

control keyboard
secpol.msc
logoff

winchat
winmine

control mouse
control NetConnect
netsetup.cpl
notepad

OSK
perfmon.msc
Perfmon
powercfg.cpl
control printers

intl.cpl

regedit
Mstsc

control schedtasks




Security Center wscui.cpl

Console management services  services.msc

Turn off windows shutdown
Sounds and Audio Devices mmsys.cpl
Spider (card game) Spider

System Configuration Editor sysedit

System Configuration Utility =~ msconfig

System Properties sysdm.cpl
System Information Dxdiag
Task Manager taskmgr
Telnet client telnet

User Accounts nusrmgr.cpl

Utility Manager (Magnifier, Utilman
etc)

Microsoft Magnifier magnify

Protection of the accounts syskey

database
Windows update wupdmgr
Wordpad write

Simple Steps to Protecting Your Computer

Hackers have thousands of tools at their disposal to take advantage of you including tools
such as keystroke loggers. Keystroke loggers record every single keystroke you type on
your computer; this includes your private email messages, your bank account password,
and your credit card number. This article focuses on Microsoft Windows users since the
majority of computer users today use a version of this operating system on their home
and/or office computers.

1. Use Strong passwords.

2. Update your computer to latest Operating System (e.g. Windows 7 or 8)
3. Update Microsoft Windows regularly.

4. Turn on Windows firewall.



5. Use antivirus software or internet security to protect your computer from virus. (e.g.
AVG anti-virus/internet security, Norton Antivirus, McAfee VirusScan, Kaspersky,
etc.)

6. Block Spyware - Spyware and viruses often go hand-in-hand but can take many
forms. Some ‘hijack’ your web browser and redirects you to their website. Others
quietly download and install Trojans, key logger programs, etc. to your computer so
hackers can take control of your computer later. Install and run an anti-spyware
program such as: Spy Sweeper, Ad-aware SE Personal

7. Keep your software up-to-date. (e.g. Microsoft Office, Adobe Rader, Adobe Flash
Player, Mozilla Firefox, Anti-virus, etc.,)

8. Backup your important data often.

CHAPTER 3
INTERNET HACKING

3.1 Introduction to Internet Hacking

Internet hacking means accessing a secure computer system by disabling or bypassing the
security. Some hackers will steal data or destroy data, or use the system to hide their
tracks as they hack into a different system and some just do it for fun. Like most cases of
extortion, the criminal’s identity is especially difficult to trace and is magnified because of
the nature of the internet. When the Internet was gaining immense popularity, businesses
were scrambling to secure domain names and using the technology to expand their
market. Seeing e-commerce as an untapped goldmine, many were eagerly diving headfirst
into a slew of problems, including security breaches. Viruses, shutdowns, crashes and
email hacking will be the burden of the user, a company’s money lost to theft will be the
burden of its customers and a government’s money spent on security will be the burden of
its citizens.

3.2 Block and unblock any website
First you have to show all hidden files, folders, and drives on your computer.

e Go to My Computer > Tools > View
e (Click on the Show hidden files, folders, and drives button.
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e Then Click OK.
Then do the followings:

1. Click Start > All Programs > Accessories > Right Click on Notepad and click on

Run as administrator

2. Then in Untitled - Notepad window click File > Open (in Menu bar). Open

dialog-box will appear.

3. Navigate to - C:\Windows\System32\drivers\etc

Then select All Files next to the File name field. (By selecting All Files option all
files are shown as shown in the below figure.)
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¥ Copyright {c) 1993-2003 microsaft Corp
"]

¥ Thisg iz a sample wOSTS File used by microsafy TCP/IP
r

# This file coantaine the sappings of IP addresies to hos
# entry should be kept on an individual line. The IF adé
F be placed tn the first colusm followed the correspe
P The IPF sddress and the hott nase dhould be teparated B
§ pace

]
’ if-ﬂ".':uml!'{. comments (such as these) may be inserted
P Tines or following the machime name denoted by a “#° s
r

F For exasple:
]

. 103 54 W97 rhing. acwe, Com # semirCe
| 38, 15,635, 10 ., ROWE , oM P xclis
# localhoit name redolution it handled within DS {toelf
0 127.0.0.1 localhost
|# S | localhest

6. Now add a new entry in the bottom, let you want to block www.facebook.com.then
add the line 127.0.0.1 www.facebook.com



7. This line means that when you try to open the www.facebook.com,then it is

redirected to IP Address 127.0.0.1, which is a back IP of the windows.

8. Save the file (by pressing Ctrl + S) and restart the computer. Then

www.facebook.com is block for all browsers.

9. To unblock it, remove the entry, which you have made and Save the file. Then restart

the computer.

Tips: This method works for all browsers.

Note: You can bypass registration of software by blocking their website and update
requests using this trick.

3.3

How to Increase Internet Speed

Many of internet users are not happy with their slow internet connections speed. So this is
the trick to increase your internet speed by yourself easily. To do this,

1.

Click on the Start button, type gpedit.msc on the search bar and then press Enter
button. Then a Local Group Policy Editor window will appear.

In Group Policy window click on Computer configuration menu. Then click on
Administrative Templates.

Click on Network. Under the Network menu click on QoS Packet Scheduler.

Under the QoS Packet Scheduler menu double click on Limit reservable
Bandwidth option.

Then in Limit reservable Bandwidth window you will find that the settings and are
disabled. But by default Limit reservable Bandwidth is eating your internet speed



by 20%. In this you have to do a simple thing. Click on Enabled button in Limit
reservable Bandwidth menu; reduce the Bandwidth by 0%.

E Limit resenvable bandwidth

Mot Configured  Cemment

& Enabled
Dhaabded
Supported 001 ) |rmct Wanda
Options:
| Bardwidth Gimit 3 20|

6. Click on Apply button and then OK.

7. Restart your computer. Congratulation you are done now.

Now connect the internet & see the difference in internet connection or your browsing
speed.

3.4 Search Internet from the Start Menu

Enable Internet search from the Start Menu using your default browser. Run gpedit.msc
from the Start Menu search box to start the Local Group Policy Editor. In the left pane,
go to User Configuration > Administrative Templates > Start Menu and Taskbar.
Then Select Add Search Internet link to Start Menu from the right pane, right-click to
Edit and Enable to add search internet link to Start menu. Click OK.
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3.5 Know any website IP address in Command Prompt

1. Press Windows logo key + R to open Run
2. Type cmd and press Enter.
3. Type ping www.websitename.com and press Enter in Command Prompt window.



Then the result shows the IP address of the website.

Example: type ping www.google.com

'..‘ tollpers SR ping wew.google .con

I' i.l? pogle.com [T4.125.236.88] with 32 bytes of datad
0 PO A6 20688 bytes=32 time=92ms TTL=G2
| Re 2. BE: I:yl:ll-:lz time =98ms TTL=G2
WReply From P4.126.236.80: byteo=32 time~-9¥mas TTL-G2
WReply from T4.120.2026.008: hr.zn-:'l tine=?ims TTL-Gd
img statiatics For T4.125.236.8@8:
Facketa: Semt = 4. Becedwed = 4. Lost = @ {8 losa),
Approsimate round trip times milli-seos
ima 1 ines in milli-secends:
Hindmam = 98ma,. Maximam = 99ma. Average = Tima
swllzera SRE>
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3.6 View Passwords hidden in asterisks

We always want the browsers to remember the username and password of our online
accounts. After a period of time, we tend to forget what the password was. It is easy to
find those passwords, if we are able to see what is behind the black dots (........ ) or
asterisks (*¥******) To know the password behind the dots then follow the steps:

1. Right click on the password textbox and from the options click on Inspect
Element(Q).

2. Then, a small window would come up with a few lines of code. You need not worry
about the codes. The line in which the password will be highlighted. If the codes are
not showing in a html format below then click on & button on the lower left corner
of that page.

3. Now double click on the term password and change it to text and press enter. Now
you see what’s behind the dots.



3.7 How to speedup online videos and performance of Firefox

By default Firefox automatically saves your session every 10 seconds so that it can be
easily restored even of a crash. But if you think 10 seconds is either too much or is not
enough, then you can change it to whatever you think is right for you, with just a little
tweak to the about:config settings. To do this,

1. Open Mozilla Firefox browser and in the address bar type about:config and press
Enter.

2. Then you will get a warning message, click on I’ll be careful, I promise.

3. Then in the filter text entry bar (on top left), type browser.sessionstore.interval

sbout:config

| Seaml  Diowser sERo e el

E

| Prefpnce Mame = Sealus Type  Vilus m

1
| Bpwiet seswons ore aienal defaull  imbeger 13000 |
|
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g benaper estaorone nben sl
; 1
120000

oK Canced

4. Just double click on it and change its value to 120000. If you want to input your own
value, then you should know that the value is actually in milliseconds. So, if you
want to change the interval to 1 minute, then you would enter 60000.

5. Click OK and restart the Firefox.



3.8 Sign-out of all Gmail sessions

If you have forgotten to sign-out from your Gmail account anywhere, you can now sign-
out from all Gmail sessions. To do this,

1. Open your Gmail account and click on the Details link in the bottom right of your
screen.

2. This will open up a pop up window where you can see recent activity, whether your
Gmail account is open in any other location, and choose to Sign out of all other
sessions.

3. Clicking that button will ensure all your previous Gmail sessions are logged out,
leaving you logged in to the current computer only.



3.9 Sign-in to multiple Google accounts in the same browser

If you use multiple Google accounts say one for Gmail another for ad-sense and yet
another for Reader, you would know that you can sign into only one account at a time in a
browser. Of course you could use separate browsers for each of the account, but it is
hassle to do so. It is a great alternative that Google has an advanced feature that lets you
sign into multiple Google Accounts simultaneously in the same browser.

In this case I will show you how to sing in multiple Gmail accounts.

Sign in to your Gmail Account.
Then at the top-left corner Click on your profile photo and click Add Account.

Then another tab opens in your web-browser. Enter another Username and
Password. Click Sign in.

Now, you are able to view your both Gmail Accounts in one web-browser.



3.10 Log in to multiple web accounts simultaneously - (Google, Gmail,
Facebook, Twitter, etc.)

Many of us have multiple accounts with one web site. Whether it be several Gmail
accounts or two separate twitter accounts or any such multiple accounts. But it is always a
hassle to have to log out of each account to access another. Follow the steps to log in to
multiple web accounts simultaneously.

In Internet Explorer 8 and higher version

Open Internet Explorer, Click on File and then New Session. This opens up a new
browser window that will allow you to log into different accounts across the sessions.
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3.11 Save any web article to PDF for free

Internet is a very huge library of information. It has millions and millions of pages of
information about virtually anything. Reading each and every article may not be possible
due to many reasons mainly due to time limitation.

The website http://pdfmyurl.com/ helps you to save the web-article to PDF format and
you can read it at anytime you want.

PDF MY URL - http://pdfmyurl.com/

1. Type http://pdfmyurl.com/ on your browser’s address bar.

| I P0feryiiL com - Fres B Onlee: Canvar.
[ oan it | F & B- O
PDFMYURL.COM
e g Wik Wirndows._ B ?
i e

2. Enter the URL (that you want to convert into pdf format). In this case I have typed
the web address http://en.wikipedia.org/wiki/Windows_8

Click ® button next to the Enter url Location field.

4. In a few seconds, this website allows you to download a PDF version of the
requested webpage.

5. Then you can download the PDF file and read even through the requested URL may

be blocked.
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Similarly, there is another website http://joliprint.com/ helps you to save and share the
pdf format of web-article. This site gives you various options for saving the file. You can
directly download it, have it send to your Email address or even can be shared using
Facebook and Twitter. In this way you can access the blocked website on the internet.

JOLIPRINT - http://joliprint.com/

1. Type http://www.joliprint.com on your browser’s address bar.



http://pdfmyurl.com/
http://pdfmyurl.com/
http://pdfmyurl.com/
http://en.wikipedia.org/wiki/Windows_8
http://joliprint.com/
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2. Enter the URL (that you want to convert into pdf format).

Click joliprint it ! button next to the Enter URL Location field.

4. In a few seconds, this website allows you to download a PDF version of the
requested webpage. You can save the PDF file to Google Docs, Gmail and share

with Facebook and Twitter.
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3.12 Free online Resume builder

A resume (also called CV: Curriculum Vitae) is a document used by persons to present
their backgrounds and skills. Resumes are the best reflections of your career. It can be
used for a variety of reasons, but most often they are used to secure new employment.
Majority of the recruiters agree that they go through each resume only for a few seconds
and that the first impression they get is from them. Hence, the resume will have to make
the first big punch for you. Having said all these, the below List of Resume builder
websites makes superb resumes for you.

List of Resume builder
websites

www.resumebuilder.org

www.cvimKkr.com

www.resumesimo.com

www.instantonlinecv.co.in
www.resumonk.com
www.resumesimo.com

www.gotresumebuilder.com

www.freeresumebuilder.biz

www.onlinecvgenerator.com

www.mycvbuilder.com

3.13 Unlock PDF and EXCEL files Online

If a PDF files have some restrictions (like Copy from the PDF file won’t work, etc.) and
password. Then the website http://www.pdfunlock.com/ helps you to remove passwords
and restrictions from secured PDF files.

1. Go to http://www.pdfunlock.com/


http://www.resumebuilder.org
http://www.cvmkr.com
http://www.resumesimo.com
http://www.instantonlinecv.co.in
http://www.resumonk.com
http://www.resumesimo.com
http://www.gotresumebuilder.com
http://www.freeresumebuilder.biz
http://www.onlinecvgenerator.com
http://www.mycvbuilder.com
http://www.pdfunlock.com/
http://www.pdfunlock.com/

2. Browse the PDF file that you want to unlock. Then click Unlock!.
3. Within few seconds, you will able to download the unlocked PDF file.

File Type Website

PDF www.pdfunlock.com

www.unlock-pdf.com

Excel www.unprotect-
excel.com



http://www.pdfunlock.com
http://www.unlock-pdf.com
http://www.unprotect-excel.com

3.14 Free online file converter

This is a nice online converter file which can be used for almost all type of files at anytime
from anywhere. To do this,

1. Go to www.online-convert.com and select the tool you want to use.

 coRvERT S

2. Suppose you wish to convert an image to PNG format. Select the conversion and
click on Go.

3. Now browse the file or enter the web URL of the image. Select the quality settings
and then click on Convert.

4. After the conversion, you will find the download link of the converted file.
Download the file.

3.15 Online Edit Photos

Upload your picture or photo or enter the URL of an image on the Internet. After
uploading, you can resize, sharpen and/or rotate your photo. Several filters and effects are
available to enhance your photo: Red Eye Removal, Sepia, Enhance, Sharpen and Polaroid
Effect.

Some popular websites are :

http://www.freeonlinephotoeditor.com/

http://www.fotor.com/

http://pixlr.com/editor/

http://web.photocat.com/edit/

http://www.befunky.com/

http://www.pizap.com/pizap

http://www.picmonkey.com/

https://www.picmonkey.com/editor



http://www.online-convert.com
http://www.freeonlinephotoeditor.com/
http://www.fotor.com/
http://pixlr.com/editor/
http://web.photocat.com/edit/
http://www.befunky.com/
http://www.pizap.com/pizap
http://www.picmonkey.com/
https://www.picmonkey.com/editor

3.16 Scan your files for malwares online for free

This is a site where in you can upload your suspected files and get them scanned for free
.An email from anyone can also have a virus or a malware which might have got attached
to the mail without his or her knowledge. Antivirus software has become an indispensable
element of your computer. It is very good for them who hate anti-viruses. Jotti’s Malware
scan is a free online service where 20 prominent antivirus software scan the files uploaded
by you and inform whether they are clean or not. The file you suspect to be infected can
be uploaded and the result is almost immediate. To do this,

1. Type the http://virusscan.jotti.org/en on your browser’s address bar.
2. Then select the file required to be scanned.
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3.17 Online trace any mobile number anywhere

You can find out all information we have on any phone number in the world. Simply enter
the phone number in international format for correct results.

Phonetrace.Org

http://www.phonetrace.org/

How does it work?
Using both GPS satellite techniques and triangulation based on phone towers.
Who makes use of this technology?

Cell phones are giving employers new ways to check up on employees in the field and
raising fresh workplace privacy concerns as a result. Law enforcement agencies have
found this technology to be the biggest breakthrough since DNA testing. Also PhoneTrace
has been in huge demand by people check up on an untrustworthy spouse!

Trace ... Mobile Number - Location Tracking with details
http://www.findandtrace.com/trace-mobile-number-location
Phone No Tracker | Online GPS Mobile Locator Using Cell Phone Number

http://gpsphonetracker.org/

GPS Phone Tracker is the first free website for finding any phone signals only with
number. Now you can start tracking your friends, kids or spouse. Phone tracker app can
locate your lost or stolen cell phone in less than 20 seconds! Try out gps phone tracker



http://virusscan.jotti.org/en
http://www.phonetrace.org/
http://www.findandtrace.com/trace-mobile-number-location
http://gpsphonetracker.org/

free online to get experience about how to track someones phone without them knowing.
Just put a phone number which you want to lookup, then get your locations for Android,
iPhone or Windows mobile devices.



3.18 Search pictures of people in 3D layout

The website www.facesaerch.com is a free website which helps you search faces of
people. This website has a very simple layout and all you need to do is to enter the
person’s name in the search box and click on search. The interface gives a 3D layout of
pictures with matching names.



http://www.facesaerch.com

3.19 Disable websites from resizing your Firefox browser window

Firefox is a very popular browser. Be it in the speed which it displays a webpage, it
downloads a file or the number of plug-in available for further making the browser user-
friendly, Mozilla Firefox stands ahead of other browsers. It is really disturbing to see
certain websites resizes the browser window. This is how to disable them doing so in

Firefox.

1. Click on Tools menu and select Options.
2. Click on the Content tab.
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3. Opposite to the check box name Enable JavaScript, you can find a button named
Advanced. Click on it.

Advanced lavaScriph Settings o |

Allow soripts to:
Wk of resize popup windows
Raise or hower windows

4 Disable or replace content menus

ok || Caneat | [ Hep

4. Uncheck the option Move or resize existing windows.
5. Click OK twice.



3.20 How to run Firefox inside Firefox inside Firefox
Open Motzilla Firefox and in the address bar type the following URL and press Enter.

chrome://browser/content/browser.xul
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You could again enter the above URL in the second Firefox that appears to open a third
one. You could repeat this as many times as your screen size permits.



3.21 YouTube SECRETS

YouTube, the extremely popular video sharing website averaging more than 3 billion page
views per day needs no introduction to its fans who spend a considerable amount of their
time watching and sharing videos on it. While most of these users know every nook and
corner of this website, there are some features that are hidden deep within, in a manner
that only few of the most experienced users seem to know about them. This article
contains some such features, tips and tricks.

YouTube MySpeed

Are YouTube videos taking too much time to load on your internet connection? Visit
the YouTube MySpeed page to find your video streaming speed and compare it with the
average speed of your ISP, your city, your state, your country and the world.

YouTube Disco

YouTube is all set to replace your music players with YouTube Disco. This music
discovery project allows you to find the videos of your choice, create a list of them and
then easily watch them without having the need to choose a new video after the one you
are watching is finished.

YouTube Editor

Do you edit your videos before uploading them to YouTube? Now, you don’t need to
because it lets you to do all of that online with YouTube Editor; well not all of that but it at
least lets you combine, trim and rotate videos. The best part about YouTube Editor is that
it allows you to find copyright free music that you can add to your videos. It also offers
some comparably advanced features like stabilizing shaky videos and inserting transitions.

YouTube TV

YouTube lets you watch the videos of your choice but have you ever wanted to just sit
back and enjoy watching videos just like you watch television? If you have, then YouTube
TV can be of help. YouTube TV plays high quality full screen videos tailored to your
choices (if you are signed in to your Google account). If you are not signed in, you can
choose a category to watch videos from, watch featured videos and even search for the
video of your choice.

Set default video playback quality

Are you annoyed at manually changing the quality of every YouTube video you watch?
Now you don’t need to, because YouTube has an option that automatically lets you select
the quality of videos you see. If you have a slow connection, you can select the option of
never playing high quality videos. You can also select the option of showing captions and
annotations automatically.


http://www.youtube.com/my_speed
http://www.youtube.com/disco
http://www.youtube.com/editor
https://www.youtube.com/tv#/
http://www.tweakandtrick.com/p/internet.html#Google
http://www.youtube.com/account_playback

Watch Videos blocked in your country with a URL trick

If the URL of the video that is blocked in your country is youtube.com/watch?v={video-
id}, you can access it by going to youtube.com/v/{video-id}. As an additional advantage,
you will be able to view the video at the full size of your browser window.

Link to a specific time in a video
If you want to link to a video at a specific time, you can add #t=XXs to the URL where
XX is a variable which represents the number of seconds after which the video will start.

Play videos in slow motion
Press the space bar while a video is being played to play it in slow motion.

YouTube Live

Ever wanted to broadcast your videos live on the internet? YouTube Live lets you do just
that. YouTube Live supports larger production than Hangouts on Air. However, to
broadcast videos live, your channel must be in good standing.

Create a feed of almost anything on YouTube

Just go to the YouTube Data API page and build a custom feed for yourself. However,
there is a problem with the URI generated for specific categories as
“{http://gdata.youtube.com/ schemas/ 2007/ categories.cat}” is also added to it. Remove
this and the URI is good to go.

Find out what is popular on YouTube

Want to find the best videos on YouTube? Use Popular on Youtube channel to find what
other users are watching, discussing and favoring. You can select a particular category to
determine the best videos in that particular category. You also have the option to play all
the videos that are popular right now.

Legally Watch Full Length Movies and TV Shows on YouTube

YouTube has a dedicated page to allow users to watch full-length ad supported movies for
free. Movies are classified based on their genre and are offered in full HD quality. Movies
are uploaded by the creators for the purpose of creating another source of revenue for
themselves as Google gives them a portion of the advertising revenue. A similar

page exists for TV shows. These two pages are country specific and may or may not be
available in your country.



http://www.tweakandtrick.com/2011/12/how-to-unblock-websites-at-school.html
https://www.youtube.com/yt/playbook/live.html
https://support.google.com/youtube/answer/2797387
http://gdata.youtube.com/demo/index.html
http://www.tweakandtrick.com/rss.xml
http://www.youtube.com/charts
http://www.youtube.com/movies
http://www.youtube.com/shows

YouTube Easter eggs

For Star Wars and Star Trek fans

If you are a Star Wars fan, then there is some good news for you. YouTube has an easter
egg just for you guys. Search YouTube for “use the force, Luke” to warp your screen. Star
Trek fans need not be disappointed as there is an easter egg for them as well. Searching
YouTube for “Beam me up, Scotty” reveals it.

YouTube Snakes Easter egg

You can play the classic Snakes game while watching any video in your browser. Just
pause a video, hold the left arrow key for 2 seconds and while still holding it, press the Up
arrow key. This only works in the new YouTube player on videos played on
YouTube.com.

do the Harlem shake
Search YouTube for “do the Harlem shake” and the entire page will shake violently with
the song “Harlem Shake” by Baauer being played in the background.


http://www.tweakandtrick.com/2010/06/watch-hidden-star-wars-in-windows-xp.html

3.22 Add Firefox’s Spelling-Check feature to forms

Mozilla Firefox comes with a cool built-in spelling checker. You could right-click the
word to see spelling suggestions along with the usual context-menu options.

1. Open Mozilla Firefox, type about:config in the address bar and press Enter.

2. Click I’ll be careful, I promise!.

3. In the Filter field, type spellcheck. Right-click on layout.spellcheckDefault, and
click on Modify.
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4. Change the value from 1 to 2 and restart Firefox. The spelling checker should now
work in most online forms.



3.23 Check username availability on multiple sites at once

Most people use a specific username or alias across a lot of sites, as it is easier to
remember and also, your friends could identify you easily in various sites with your
username. But it could be very frustrating, when you try to sign up on a new site only to
find that your username is already taken. Checking for availability of your chosen
username in several sites of interest could be a daunting task. Fortunately, there is an
easier way.

www.usernamecheck.com is a site, in which you can use to check the username
availability on multiple sites at once. You can type in your desired name
usernamecheck.com will scan over 20 social networks and services and tells you within
seconds whether the username is available or taken. If it is available, it provides Thumbs
Up sign to the site, where you can sign up before someone else takes your name.

3.24 You don’t need the “http://” portion of a web page on Address
bar/Location bar

When typing an Internet address you do not need to type http:// or even www. in the
address.

For example, if you want to visit Geogle you could just type google.com and press Enter.
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Type google.com and press Enter (Left) : Type google and press Ctrl + Enter (Right)

To make things even quicker, if you’re visiting a .com address you can type google and
then press Ctrl + Enter to type out the full http://www.google.com address.

3.25 Take advantage of tabbed browsing

Take full advantage of tabbed browsing in all Internet browsers. While reading any web
page if you come across a link you may be interested in open that link in a new tab so it
can be viewed later. A new tab can be opened by holding down the Ctrl key and clicking
the link or if you have a mouse with a wheel click the link with the middle mouse button.


http://www.usernamecheck.com
http://www.google.com

3.26

If you’re filling out an online form, e-mail, or other text field you can quickly move
between each of the fields by pressing the Tab key or Shift + Tab to move back a field.

e To move Forward, press Tab key.

Quickly move between the fields of a web page

e To move Backward, press Shift + Tab key.

For example, if you’re filling out your name and the next field is your e-mail address you

can press the Tab key to switch to the e-mail field.

Tips

e This tip also applies to the buttons, if you press tab and the web developer has
designed correctly the button should be selected and will allow you to press the Space

bar or Enter to push the button.

e If you have a drop-down box that lists every country or every state you can click that
box and then press the letter of the state or country you’re looking for. For example,
is a drop-down box of States in the India you could press u on the keyboard to quickly

scroll to I types.

3.27

Google

Googin Saarch

Go to Google Home Page (www.google.com) and type the following codes and click I’m
Feeling Lucky button right next to the Google Search button. You must Turn off Instant

Google “I’m Feeling Lucky” button Magic Tricks

search (from Search settings option).

google sphere  google

gravity

weenie google lol limewire

rainbow let it snow
google

google  heart epic box
page

google magic  sexy snape

GoHarsh Google God

google mirror

epic google

tilt

who’s awesome

Google Pirate

Google Gothic

Type the following codes and click I’m Feeling Lucky button

right next to the Google Search button.

google pacman

annoying
google

google loco

who is the
cutest

Google Hacker

Google Piglatin



http://www.google.com

“Googlo” Google Pond  Translate for Funny Google
Animals

Google Google Google Guitar do a barrel roll

Blackle Variations

Google Google “color How Huge Is amIawesome

“country name” Google?

name” (Infographic)

Tips:

e Type Google “country name” and click on I’m Feeling Lucky. For example type
google china and click on I’m Feeling Lucky.

e Type Google “color name” and click on I’m Feeling Lucky. For example type
google blue and click on I’m Feeling Lucky.

Example of Google mirror
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If you click Google Search button after type the code, then you have to click on the first
web-search option.
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3.28 Google Results page full overview
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Header

Search bar

Search results
Tools & filters
Right-hand section
Bottom of the page
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3.29 Google Calculator

Google search can be used as a calculator. It can calculate anything from the simplest
math to the most complex equation. Enter any math equation into the search box and we’ll
calculate your answer.

Example: Type 100 * 3.14 - sin(65) and Click Google Search or Press Enter.

313.173171321

3.30 Search with an exact phrase in Google

Put quotation marks around words “any word” to search for an exact phrase in an exact
order. Keep in mind that searching with quotes might exclude relevant results. For
instance, a search for “Alexander Bell” will miss pages that refer to Alexander G. Bell.

Example: Type “to be or not to be” and Click Google Search or Press Enter.

GO ( ﬁglﬁ



3.31

There are various kinds of files available over the net. Searching for a specific file type
isn’t really easy. But using this tip you can easily search for a specific file type. Search for
specific types of files, such as PDFs, PPTs, or XLS, by adding filetype: and the 3-letter

Search for specific file types in Google

file abbreviation.

Example: Type filetype:pdf Computer or Computer filetype:pdf and Click Google

Search or Press Enter.
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3.32

Convert any measurement — like miles to kilometers or ounces to liters — by typing in
the number and unit of measurement.

Example: Example: Type 5km to cm and Click Google Search or Press Enter.
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Skm o cm
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Google Measurement Converter

- 500000

Cortareis:

3.33

Get current exchange rates by searching [currency 1] in [currency 2].

Example: Type 1% in INR and Click Google Search or Press Enter.

Currency conversions in Google



15 mINR

1 U5 dollar = 56.1800 Indian rupees

3.34 Exact time of any place in Google

To see what time it is anywhere in the world, search time and the city or country. If you
want to see the local time, then just type time and Press Enter. If you want to know the
time in a specific city or country, then type time city/country name and Press Enter.

Example: Type time london and Click Google Search or Press Enter.

fime london

3:54 Saturday (GMT) - Time in London, UK

3.35 Check the weather of anywhere in Google

If you want to see the local weather, then just type weather and Press Enter. If you want
to know the weather of a specific city or country, then type weather city/country name
and Press Enter.

3.36 Get Sunset and Sunrise time of anywhere in Google
To Get Type and Press Enter
Local Sunrise time sunrise
Local Sunset time sunset

City/Country Sunrise time  sunrise city/country name

City/Country Sunset time sunset city/country name

3.37 Get definitions of everything in Google

If you want to know the definition of anything, and then type define any word & Press
Enter to get its definition.

Example: Type define computer and Click Google Search or Press Enter.



define computer

COM-PUL-8F  focen pyoifad 47

An electionic desice for slorng and processing data, typcally in binary
form. according to instructions green to it n a variable program

2. A person who makes calculations. esp. vath a calkeulating machine.

calcufator

More infio s Whlopedia - Dictionary com - Angwers com - Merriam-Webster

3.38 Trace My IP Address

If you want to know the exact IP address of your computer, then type my ip & Press
Enter.

Example: Type my ip and Click Google Search or Press Enter.
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3.39 Search by advanced image search in Google

1. Go to Google Image.
2. Enter the search item in the search bar.
3. Use Search tools to find an exact size, color or type of photo or drawing.

Google  waipape PO
2

T
4. With the tools in the bottom panel, you can filter your search to include only photos

with faces, clip art, high-res images or only images that are available for commercial
use.

3.40 Get movie times in Google



Search on a movie name or just movie to see theater locations and showtimes in your area.

Example: Type movies washington and Click Google Search or Press Enter.

Lo qh_ move washnglon de
s

Fioaies tof Washington DC

3.41 Get the list of all films of any Actor and Actress

Go to www.google.com

Type Actor/Actress name movie and Press Enter.

Example : Al Pacino movie

Al Pacing

3.42 Google URL shortener

The Google URL Shortener at https://goo.gl/ is a service that takes long URLs and
squeezes them into fewer characters to make a link easier to share, tweet, or email to
friends. For example, the short URL http:/goo.gl/vOSOu is a convenient shorthand
representation for the long URL

http://www.latimes.com/business/la-fi-windows-surface-20121130,0,474887..story
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Google url shorenes
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Go to http://goo.gl/ and paste the long URL you wish to shorten into the input box at the
top of the page. Click Shorten and to the right of the box you’ll see a short goo.gl URL


http://www.google.com
https://goo.gl/
http://goo.gl/v0SOu
http://www.latimes.com/business/la-fi-windows-surface-20121130,0,474887.story
http://goo.gl/

that can be copied and pasted anywhere you’d like to share it.

If you’d like to track the analytics of your shortened URL, please sign in to your Google
Account before shortening your URL. Your shortened URL will automatically be added to
your goo.gl history.

3.43 Google Earth

Google Earth is a virtual globe, map and geographical information program that was
originally called EarthViewer 3D.

Google Earth allows you to travel the world through a virtual globe and view satellite
imagery, maps, terrain, 3D buildings, and much more. With Google Earth’s rich,
geographical content, you are able to experience a more realistic view of the world. You
can fly to your favorite place, search for businesses and even navigate through directions.
It’s all up to you!

Although the options within Google Earth are endless, here are a few things you can do:

e Discover the Earth: Fly to any location in the world, learn about a city and it’s
geographic features, find local businesses, and create tours.

e Explore the Sky: Enjoy the wonders of the heavens and learn about our solar system.

e Dive in the Ocean: Go beneath the surface and visit the depths of the ocean and
explore the planet’s deepest underwater canyons. Learn about ocean observations,
climate change, and endangered species. You can even discover new places to surf,
dive and fish.

e Walk on the Moon: Take tours of landing sites narrated by Apollo astronauts and
view 3D models of landed spacecraft.

e Visit Mars: Travel the Red Planet and explore NASA’s latest imagery of our galactic
neighbor.

Google Earth is simply your ticket to explore the Universe!
To explore the earth in 3D view:

1. Go to http://www.google.co.in/earth/

Lo ]

2. Click Download
3. After completion of download, open Google Earth.


http://www.google.co.in/earth/

4. Search any location in 3D view.

3.44 Most useful Google Operators

The following table lists the search operators that work with each Google search service.
There is no space between operator and keyword. Ex. software site:www.download.com

Operator Example
Site: software
site:www.download.com

will find all sites containing the
word software, located within the
download.com domain

Intitle: intitle:google hacking

will find all sites with the word
google in the title and hacking in
the text

Allintitle: allintitle:google hacking
will find all sites with the words
google and hacking in the title

Inurl: inurl:google hacking

will find all sites containing the
word hacking in the text and
google in the URL

Allinurl: allinurl:google hacking

will find all sites with the words
google and hacking in the URL

filetype: filetype:pdf hacking




(or ext:)

Numrange:

Link:

Inanchor:

Allintext:

cache:

info:

(orid:)

related:

«»

OR

will return PDFs containing the
word hacking, while filetype:xls
hacking will return Excel
spreadsheets with the word
hacking
numrange:50000-100000 car

will return sites containing a
number from 50000 to 100000
and the word car. The same result
can be achieved with
50000..100000 car

link:www.google.com

will return documents containing
one or more links to
www.google.com

inanchor:hacking

will return documents with links
whose description contains the
word hacking (that’s the actual
link text, not the URL indicated
by the link)

allintext:google hacking

will return documents which
contain the phrase google
hacking in their text only

cache:www.timesofindia.com
will display Google’s cached
version of a web page, instead of
the current version of the page.
info:www.google.com

will find the information about
www.google.com
related:www.timesofindia.com
will find websites related to the
timesofindia website.

~hacking

will find the synonym

“windows hacking”

will find the phrase

computer OR laptop

will find the results include either




search term.

- ipod —itunes
use — immediately before a search
term you want to exclude

+ +the

use + immediately before
automatically excluded search
terms that you want included

3.45 Google help center
If you have the curiosity about Google, then the following website helps you out.
% > o M @ 3} €

Help Website
Center

Google https://support.google.com
Help

Center

Google+ https://support.google.com/plus
Help

center

Google https://support.google.com/googleplay
Play Help

center

YouTube https://support.google.com/youtube
Help
center

Gmail https://support.google.com/mail
Help
center

Web https://support.google.com/websearch
Search

Help

center

Google https://support.google.com/maps
Map Help
center

Google https://support.google.com/chrome/
Chrome

Help

center



https://support.google.com
https://support.google.com/plus
https://support.google.com/googleplay
https://support.google.com/youtube
https://support.google.com/mail
https://support.google.com/websearch
https://support.google.com/maps
https://support.google.com/chrome/

Google www.google.com/insidesearch/features/
Features

3.46 Backup all your facebook data like photos, videos, and text

1. Login to your Facebook account.

'/I

2. Click on the Arrow dropdown and then Settings.

3. In General tab Click on Download a Copy at the bottom of page to backup your

Facebook data.

Click on Start My Archive button twice.

Click on Confirm button.

6. Now, Facebook will generate your personal archive and send to your default Email
ID when it’s ready.

ok

3.47 Facebook shortcut keys
Facebook has shortcuts (access keys) for people who only use their keyboards to navigate.

Find the right combination of keys for your browser in the list below, and replace # with
the access key number listed under Access Keys below.

. Internet Explorer for PC: Alt + #, then Enter
. Firefox for PC: Shift + Alt + #

. Safari for Mac: Ctrl + Opt + #

. Firefox for Mac: Ctrl + Opt + #

. Chrome for Mac: Ctrl + Opt + #

. Chrome for PC: Alt + #

Access Keys
. 0 - Help
. 1 - Home

. 2 - Timeline

. 3 - Friends

. 4 - Inbox

. 5 — Notifications
. 6 — Settings

. 7 - Activity Log
. 8 - About


http://www.google.com/insidesearch/features/

9 - Terms

Keyboard Shortcuts

News Feed

j and k - Scroll between News Feed stories
enter/return - See more of the selected story

p - Post a new status

1 - Like or unlike the selected story

¢ - Comment on the selected story

s - Share the selected story

o - Open an attachment from the selected story
/ - Search

g - Search chat contacts

? - Open a list of these keyboard shortcuts while in News Feed

Web Messenger:

CTRL + g - Search conversations

CTRL + q - Show/hide keyboard shortcuts

CTRL + Delete - Archive/unarchive conversation
CTRL + j - Mark as spam

CTRL + m - Start a new message

CTRL + i - Go to Inbox

CTRL + u - Go to Other






3.48 How to deactivate or permanently delete a Facebook account
If you would like to delete your Facebook account, then

1. Login to your Facebook account.
2. Click on the Arrow dropdown and then Settings.

'/I

On the Security tab click on Deactivate Your Account at the bottom of page.

4. Confirm Facebook Account Deactivation page will load. Select one of the reasons
why you want to delete your Facebook account and click on confirm button.

5. Your facebook account will be deactivated after again choosing the Deactivate

button on next step.

w

If you would like to delete your Facebook account permanently with no option for
recovery, then

1. Log in to your Facebook account.

2. Open https://www.facebook.com/help/delete_account in your browser
3. Click on delete my account.

Your facebook account will be deleted after choosing reasons why you want to delete
your Facebook account and click on confirm button.

3.49 Post blank status and comment on facebook

This is an amazing trick to post blank status and comments on Facebook means your
status update shows nothing and your friends will be amazed to see this.

Updating Blank Status

To update a blank status,

1. Log in to your Facebook account.

2. Click on Update Status box and Press the ALT key, hold it, and type 0,1,7,3 without
those commas (ALT+0173).

3. Click on Post.

Tips: If you want to post multiple blank lines, then you should type the above code line by
line.

Posting Blank Comments

Posting a blank comment is pretty much the same as creating a blank file or folder in
windows. If you missed that article, catch it now.

Okay, so to post a blank comment all you have to do is press the ALT key, hold it, and


https://www.facebook.com/help/delete_account

type 0,1,7,3 without those commas (ALT+0173). Remember, do not release the alt key
while typing. Now leave all the keys and press enter.

3.50 Insert symbols and characters in Facebook status and comments
This is a cool trick to update Facebook status

1. Log in to your Facebook account.

2. Go to http://fsymbols.com/

3. Click and Copy the symbols and characters which you want to insert in facebook
status

4. Paste it in your facebook status and comments

L= =
g,

[Sgrrbals

Facebook symbols e

Note : Another website for your interest

http:/www.symbols-n-emoticons.com/p/facebook-emoticons-list. html

3.51 How to block people/apps/events/pages on facebook
To do this,

1. Log into your Facebook account.

2. Click on the Arrow dropdown and then Settings.

3. Click on Blocking on the left panel.
4. Then block anything you want.

3.52 View Facebook Photos in Full Screen Mode

Now Facebook has published out new photo viewer. This feature allows users to view
Facebook photos in full screen mode.

1. First open a photo by clicking on it.


http://fsymbols.com/
http://www.symbols-n-emoticons.com/p/facebook-emoticons-list.html

2. Place the mouse pointer on it and click on Options at the bottom right of the photo.
3. Click on Enter Fullscreen for view facebook photos in full screen mode.
4. That’s it and now use Esc key for exit full screen mode.

3.53 How to find if somebody hacked your facebook account

Now-a-days everybody wants to know everyone’s facebook password. So if they will get
your password then your facebook account will be used in a bad way. This is a method to
know who opens your account silently. To do this,

1. Login to your Facebook account.
2. Click on the Arrow dropdown and then Settings.

.-'/I:.I
3. Click on Security tab, choose Where You’re Logged In option.

Find out the locations with time and devices to trace out whether you logged in or
not at that time.

4. 1If you want to logout from that session then click on End Activity.

.54 How to Block Facebook Applications Forever

5
1. Log into your Facebook account.

2. Click on the Home-dropdown and then Privacy Settings.

3. Click on Edit settings under Ads, Apps and Websites section.
4. Click on Edit settings.

5. Close all platform apps one by one.

.55 Who can look me up? On Facebook

5
1. Log into your Facebook account.

2. Click on the Arrow dropdown and then Settings.

3. Click on Privacy tab

4. Under the Who can look me up? Edit your desired settings.



3.56 Facebook Emoji

Facebook includes a long list of emoji and emoticons that users can use in messages,
status updates, comments and basically any place there is text on Facebook. You can use
the emoji keyboard on your iPhone or Android, but you can also type out Facebook
emoticon short codes in Facebook.

FACEBOOK SHORT NAME

EMOTICON CODE

&, ) Like
iT 0:) Angel
3:) Devil
E 8-) Glasses
Q <3 Heart
&) ok Kiss

g v Pac Man
1 <() Penguin
_L'; ] Robot
123 (M) Shark
(=) -0 Gasp
& p Tongue Out

¥

>
>
>

© _ Kiki



http://www.gottabemobile.com/2014/05/20/facebook-emoticons-guide-tips-tricks-lists/
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Like.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Devil.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Glasses.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Heart.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Kiss.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Pac-Man.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Penguin.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Robot.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Shark.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Gasp.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Tongue.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Kiki.jpg

4 8-| Sunglasses

% :poop: Poop

=~/ 3 Goofy Face /
Cat

The list of Facebook emoticons above includes the short code that you need to type in to
Facebook to make the emoji. You can also copy and paste the short code from this list.

3.57 Convert Facebook Profile into a Page

The method is very cool as you will no need to individually invite all your friends to like
your page as you will be just converting the Facebook profile into the page. So just follow
up some of simple steps below to proceed.

1. First of all login into your profile which you want to migrate to a Facebook page.

2. Now open the link to migrate your profile.

3. Now you will see all the category in which you can change your page, select any of

your choice or need.

Now agree the Facebook terms and conditions and proceed.

Note that converting your facebook profile into a page will lost all your facebook

data and your friends will convert into your page likes.

6. Facebook will ask you some security question while proceeding answer them and
proceed.

7. That is it you are done now your profile get completely converted into a page, share
your links and media there.

3.58 Verify Facebook Page or Profile

ok

Facebook Page Verification method only four type of verification of pages or profiles in
2015 which are :-

Journalists

Popular Brand or Businesses
Government Officials
Celebrities

These are the four categories of pages or profile which can be verified by Facebook with
the new method of verification facebook page or profile 2015. Suppose if you have any
local business which is popular then Facebook may claimed your page if you are
official. And then there is no need to submit any type of request to Facebook for page
verification. They automatically claim your page as verified depend on some details and
minimum requirements mention by Facebook.

If you have pages mentions above there will be chances to get your page or profile is


http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Sunglasses.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Poop.jpg
http://cdn.gottabemobile.com/wp-content/uploads/2014/05/Facebook-Emoticon-Wiggle-Lips.jpg
https://www.facebook.com/pages/create.php?migrate

verified and your Facebook page must be official represent your local business or any
personality and may be have some popularity on Facebook. When you create Facebook
page fill all the real info about your or your business so Facebook will get to know that
your real person. You need to follow some instructions :-

1. Link To Your Profile or Page From Official Website on your page or profile which
you want to verify facebook page 2015.

2. Provide accurate information in details about your business in About Section of
Page or Profile.

In About section you must add :

Significant long and short description,

Keyword who represent your business,

Email,

Official Website,

Products and

Verified Facebook Page Location with claimed business address

And Other details in Page Info tab.

To send them Facebook page verification “Request a verified Badge” request you
need to follow the link given below and fill the real information.



REQUEST FOR FACEBOOK PAGE OR PROFILE VERIFICATION

Click to open the below link

Facebook Mentions is only available to people with verified Facebook profiles or Pages.
To request a verified badge for your Page, please fill out this form. Fill in the required
information and send request and then you are done.

3.59

Accept/Reject all Facebook Requests at once

The method is very simple and easy as you just have to use a simple Google Chrome
extension that will work for you to accept or rejects all the friends’ requests at once. Just
follow the simple steps discussed below to proceed.

3.60

1. First of all in Google Chrome Browser open and install the extension Facebook
Friends Requests Accept/Reject from here.

2. Now a Facebook Friends Requests Accept/Reject icon at right top corner of
chrome.

3. Now open the link https://www.facebook.com/friends/requests and you will see
all the Facebook request of your account.

4. Now click on the Facebook Friends Requests Accept/Reject icon at right top
corner of chrome.

5. Now it will ask you for accept all or reject all just select according to your wish
and then refresh the page.

6. Now you will see all friends request will be accept or reject accordingly you had
selected.

Delete all Facebook Messages at once

First of all you need a simple browser extension that is available for both the Google
Chrome and Mozilla Firefox.

For Google Chrome download and install it from here and For Mozilla Firefox
download and install it from_here.

Now after you installed these browser extension just proceed with login into your
Facebook account whose messages you want to delete.

Now go to your Facebook inbox where you will see all the messages that you have
done with your friends.

Now at the top right corner of your browser you will see Facebook Delete All
Message Extension’s icon, just click on it.

Now after clicking on it you will receive a popup confirming your action to delete all
Facebook messages just confirm it.

After a moment you will see All Chat History will get deleted.


https://www.facebook.com/help/contact/1448613808726619
https://goo.gl/trAH3V
https://www.facebook.com/friends/requests
https://goo.gl/6hJgeB
https://goo.gl/X0Ukua

3.61 Hide last seen in Facebook chat

Hipe LAST SEEN IN FACEBOOK CHAT IN GoOoGLE CHROME

First of all install and open the Google Chrome Browser of your computer.

Now in the browser open the link by clicking here.

Now you will see Facebook unseen extension in the page displayed.

Now click on install there and installation process will begin and the extension will
get added in your browser.

5. That’s it you are done now you can easily see all the message without showing the
seen on that with this extension.

Ll e

Hipe LAST SEEN IN FACEBOOK CHAT IN MozirrA FIREFox

1. First of all install and open the Mozilla Firefox Browser of your computer.

2. Now install the plugin stealth by clicking here.

3. That’s it you are done now you can easily see all the message without showing the
seen on that with this extension.

3.62 Wayback Machine

It is a digital archive of the World Wide Web and other information on the Internet created
by the Internet Archive, a non-profit organization, based in San Francisco, California. It
was set up by Brewster Kahle and Bruce Gilliat, and is maintained with content from
Alexa Internet. The service enables users to see archived versions of web pages across
time, which the Archive calls a “three dimensional index.”

Since 1996, they have been archiving cached pages of web sites onto their large cluster of
Linux nodes. They revisit sites every few weeks or months and archive a new version if
the content has changed. The intent is to capture and archive content that would otherwise
be lost whenever a site is changed or closed down. Their grand vision is to archive the
entire Internet.

The name Wayback Machine was chosen as a droll reference to a plot device in an
animated cartoon series, The Rocky and Bullwinkle Show. In one of that animated
cartoon’s component segments, Peabody’s Improbable History, lead characters Mr.
Peabody and Sherman routinely used a time machine called the “WABAC machine”
(pronounced wayback) to witness, participate in, and, more often than not, alter famous
events in history.

1. Go to http://archive.org/web/


https://goo.gl/nt3L9i
http://goo.gl/md4zVx
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2. Then in the search bar enter the Website URL, which you wish to go back in it.

Then click on BROWSE HISTORY.

4. Select a date on that calendar and go you are now seeing the page of history of that
website.

w

3.63 WEB proxy server or HI'TP proxy server

In computer networks, a proxy server is a server (a computer system or an application)
that acts as an intermediary for requests from clients seeking resources from other servers.
A client connects to the proxy server, requesting some service, such as a file, connection,
web page, or other resource available from a different server and the proxy server
evaluates the request as a way to simplify and control its complexity. Proxies were
invented to add structure and encapsulation to distributed systems. Today, most proxies are
web proxies, facilitating access to content on the World Wide Web and providing
anonymity.

I/ 6. h Aot wha "\I _.-"" What is \
\the current time | \, the current time
s — —
Alice Pr\c:x,'
_,-’".'

s h T T .
i :Il:n says the # The time \|
2 Topm z.- I"._ is 7pem v,

Communication between two computers (shown in grey) connected through a third
computer (shown in red) acting as a proxy. Bob does not know whom the information is
going to, which is why proxies can be used to protect privacy.

List of WEB proxy servers or HTTP proxy servers

https://www.hidemyass.com/proxy

https://zend2.com/

https://kproxy.com/

https://hide.me/en/proxy

https://www.proxfree.com/

https://www.filterbypass.me/



https://www.hidemyass.com/proxy
https://zend2.com/
https://kproxy.com/
https://hide.me/en/proxy
https://www.proxfree.com/
https://www.filterbypass.me/

https://zendproxy.com/

WWW.anonproxy.eu/

www.cyberghostvpn.com/en/proxy
http://proxy.org/
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Glype

A web-based proxy script is hosted on a website which provides a proxy service to users
via a web browser. A proxy service downloads requested web pages, modifies them for
compatibility with the proxy, and forwards them on to the user. Web proxies are commonly
used for anonymous browsing and bypassing censorship and other restrictions.

Glype : https://www.glype.com/
Glype Downloader : https://www.glype.com/download.php

Glype is a web-based proxy script written in PHP which focuses on features, functionality,
and ease of use. Webmasters use Glype to quickly and easily set up their own proxy sites.
Glype helps users to defeat Internet censorship and be anonymous while web browsing.
There have been over 949,000 downloads of Glype since 2007. Thousands of web-based
proxy websites are powered by Glype.

Glype Features

3.65

Free for personal use and licensing options are available for commercial use.

Source Viewable and webmasters may modify the source code subject to the terms of
the Software License Agreement.

Plug and Play. Simply upload, configure and go!

Admin Control Panel for easy management and configuration.

JavaScript Support provides increased compatibility with websites.

Skinable. A theme system allows for customization of your proxy.

Access Controls blacklist users by IP address and websites by domain name.
Blocked.com Integration protects the proxy by blocking specificed countries, filtering
companies, malicious traffic, bots and spiders, and more.

Unique URLs provide greater privacy by expiring URLs in the browser history at the
end of a browsing session.

Plugins allow for easy installion of site-specific modifications. Useful for adding new
functionality to websites.

Advanced Options let users change their user-agent and referrer, manage cookies, and
remove JavaScripts and Flash.

Hide-My-IP.Com

This is a tool which, once installed on your computer, will allow you to bypass censorship,
hide your identity and surf the internet anonymously.


https://zendproxy.com/
http://www.anonproxy.eu/
http://www.cyberghostvpn.com/en/proxy
http://proxy.org/
https://www.glype.com/
https://www.glype.com/download.php

https://www.hide-my-ip.com/

Surf anonymously, prevent hackers from acquiring your IP address, send anonymous
email, and encrypt your Internet connection. Protect your online privacy by changing your
IP with Hide My IP.

& HIDE MY IP RE— _q_
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JonDo — the IP changer

3.66
Jmﬂﬁmm

https://anonymous-proxy-servers.net/en/jondo.html

You may use JonDonym for anonymous surfing, anonymous e-mail, chats and other
purposes. JonDo, formerly JAP, is the ip changer proxy tool you have to install on your
computer. It acts as a proxy and will forward the traffic of your internet applications
multible encrypted to the mix cascades and so it will hide your ip address. It is a Java
application, open source and you can download it for free. You may use JonDonym for
free, but free mix cascades are restricted in some cases.

JonDo will provide an anonymisation proxy for you, but it does NOT change your system
setting. You have to configure the proxy setting of each internet application you want to
use anonymous with JonDonym by self.

3.67 VPN (Virtual Private Network) Services

What’s a VPN service? If you’ve ever had to connect to a corporate network while
working remotely, you may already be familiar with the technology. In simplest terms, you
are creating a secure, encrypted connection between your computer and your company’s
VPN server. This tunnel essentially makes you part of the company’s network, as if you
are physically sitting in the office. All your network traffic passes through this protected
tunnel, and no one in the hotel you are staying in can see what you are up to. The VPN
service is essentially the same idea, except the VPN provider is not letting you have access
to its network, but rather offering secure access to the Internet.


https://www.hide-my-ip.com/
https://anonymous-proxy-servers.net/en/jondo.html

Think about it this way: if your car pulls out of your driveway, someone can follow you
and see where you are going, how long you are at your destination, and when you are
coming back. With a VPN service, you are essentially driving into a closed parking
garage, switching to a different car, and driving out, and no one who was originally
following you knows where you went.

There is a caveat to this metaphor, though. Just as the person who was following you
could figure out where you went if he or she happened to be at the supermarket when you
got out of the car, there are complicated timing algorithms that can figure out your activity
at the exact moment you leave the encrypted tunnel. VPN services, while tremendously
helpful, are not fool-proof. As with anything else on the Internet, don’t do anything stupid.

There are several reasons why you should use VPN services: to change your IP address to
something else, to prevent anyone from eavesdropping on your online activity while you
are connected to Wi-Fi networks, and to make it harder for online advertisers to track you.
There are activists who rely on VPN services to get around government censors to
communicate with the outside world. Of course, that may be against the law in countries
with strict censorship, so be careful.

VPN services are very useful and we highly recommend using them to protect your online
activity from malicious snoops. Yes, you can change your IP address to pretend to be from
someplace else in order to access content that may be restricted on a geographic basis. But
be smart: don’t ignore the company’s terms of service in order to get around the
geographic restrictions for your own personal gratification. You can’t complain if you get
caught.

How to Pick a VPN Service

The VPN services market has exploded over the past three years. Many providers are
capitalizing on the general population’s growing concerns about surveillance and cyber-
crime, which means it’s getting hard to tell when a company is actually providing a secure
service and when it’s throwing out a lot of fancy words while selling snake oil. It’s
important to keep a few things in mind when evaluating which VPN service is right for
you: reputation, performance, type of encryption used, transparency, ease of use, support,
and extra features. Don’t just focus on price.

Despite widespread agreement that VPN services are important to online privacy, you
don’t actually see a lot of big-name security companies getting into the game. Symantec
was one of the first security companies to dip its toe into the VPN pool, but it has since
discontinued its Norton Hotspot Privacy product. F-Secure (Freedome) and Avast!
(SecureLine) are among the few security companies still in the space. Most VPN
providers tend to be stand-alone companies, such as Spotflux and AnchorFree (Hotspot
Shield Elite), which makes it a little harder to figure out who to trust. I tend to trust
companies that have been around a little longer, just because if they are terrible to their
customers, then it would be easier to uncover the complaints than if the company just
popped up a year ago. But your mileage may vary when looking at the company
reputation.



Performance is a must when considering VPN services. When you didn’t have a lot of
choices, you expected to have hiccups and lags while online. Now that there are services
that still give you a great experience online while keeping you secure, there is no reason to
accept slow speeds or servers which are frequently offline. We spend about a week testing
each service at varying times of the day and from different locations to make sure we get a
good idea of what the overall service is like. Look for services that provide a free trial, and
take advantage of it. Make sure you are happy with what you sign up for, since most of
them will not give you any refunds. This is actually why I also recommend starting out
with a short term—a week or a month—to really make sure you are happy. Yes, you may
get that discount by signing up for a year, but that’s a lot of money to lose if you realize
the service doesn’t meet your performance needs.

I am not a cryptography expert so I can’t verify all of the encryption claims providers
make. I do know that when I looked at my network traffic using tools such as Wireshark,
they were encrypted. I verified that what URLSs I visited and what data I was submitting on
forms were not transmitted in plaintext. At the very least, there would be no virtual
eavesdropping by the person sitting in the coffee shop. I prefer providers that use
OpenVPN—it’s a standard, and it’s a lot better than the common (and older) PPTP. I am
not saying do not use PPTP—it’s still preferable to not having anything at all.

Transparency is a big one for me. Is it easy to find the terms and conditions and privacy
policy for the service? Does the privacy policy spell out what the service does, what it
collects, and what its responsibilities are? There are companies that explain they collect
some information but aren’t clear on how it is being used. Some—like HideIPVPN—tell
you upfront that P2P and torrenting is not allowed, and that they will cancel your account
if they suspect you of using it while connected to their service. I appreciated TorGuard’s
clear explanation of how it keeps track of payment card information without maintaining
any logging information. Find out where the company is based—some countries don’t
have data retention laws so it is easier to keep the “We don’t keep any logs” promises.

What kind of user are you? Some people are comfortable setting up the service by
downloading a configuration file and importing it into the OpenVPN client. Others just
want a simple executable to download, install, and be up and running. Or you may prefer
something small and invisible operating in the background you don’t have to think about.

A decent VPN service should be easy enough to use that you don’t have to worry about
support. But you want help available for when things go wrong. Online tutorials and
extensive documentation should be a must. Chat support and phone support are definitely
useful for those times when you just need to get a person online. If the service accepts
alternate payments, that’s a good thing to look at. I’ve yet to use Bitcoin to sign up for any
of these services, but I’ve used pre-paid cards to sign up for some. It’s a little bit more
work, but sometimes, it’s not a bad idea to keep some payments separate from your main
credit card.

Finally, know what you are looking for. Do you just want a vanilla VPN service that just
encrypts your connection and gives you a brand-new IP address? Or are you looking for
something more? I personally prefer a service which acts proactively and shuts down



certain applications if my VPN connection drops suddenly (Kill Switch). Perhaps you
want the service to automatically turn on—or prompt you to turn on—if you launch a
browser. Or you want some kind of network metering so that you can track your usage.
Perhaps you want to block aggressive advertising trackers. If you are a heavy BitTorrent
user, don’t select a VPN service which specifically says it won’t allow P2P or torrents.

3.68 Useful Extensions and Add-ons

For Google Chrome : https://chrome.google.com/webstore/category/extensions
AdBlock

The original AdBlock for Chrome. Block all advertisements on all web pages,
even Facebook, Youtube, and Hulu.

It works automatically: just click “Add to Chrome,” then visit your favorite
website and see the ads disappear!

You can also get AdBlock for Safari, Opera, and Firefox from getadblock.com.
Adblock for Youtube
Removes the video ads from Youtube
Facebook AdBlock
Tired of Facebook ads?

No problem ! Just install this AdBlock extension and all your problems are
gone.

This Facebook AdBlock will remove the ads from your Facebook page, to
leave you with clean Facebook pages.

Photo Zoom for Facebook

Join nearly 5 million people using Photo Zoom for Facebook, the Highest
Rated Most Popular Extension for Google Chrome!

FlashControl
FlashControl prevents Flash content from loading unless you allow it.
Google Dictionary (by Google)
View definitions easily as you browse the web.
Google Mail Checker

Displays the number of unread messages in your Google Mail inbox. You can
also click the button to open your inbox.

Popup Blocker Pro


https://chrome.google.com/webstore/category/extensions

Blocks unwanted popups and popunders on sites you visit.

You will see a notification when any popup is blocked. You can add sites to
whitelist to ignore this.

White list is synchronised to all chrome browsers that you are signed in.
Ghostery

Protect your privacy. See who’s tracking your web browsing with Ghostery.
Silver Bird

Silver Bird is a Twitter extension that allows you to follow your timelines and
interact with your Twitter account.

WOT

WOT helps you find trustworthy websites based on millions of users’
experiences and is one of Chrome’s most popular add-ons

Video Downloader professional

Download videos from web sites or just collect them in your video list without
downloading them.

Turn Off the Lights

The entire page will be fading to dark, so you can watch the videos as if you
were in the cinema

LastPass: Free Password Manager

LastPass, an award-winning password manager, saves your passwords and
gives you secure access from every computer and mobile device

Click&Clean

Deletes typed URLSs, Cache, Cookies, your Download and Browsing History...
instantly, with just 1-click on Click&Clean button

Speed Dial [FVD]

New Tab Page Replacement with 3D Speed Dial and predefined images, sync
and organize your bookmarks, groups, and most visited

Facebook Invite All

Automatically invite all your facebook friends to Events or Pages with just one
click

Todoist: To-Do list and Task Manager

Todoist is the leading online to-do list and task manager. We manage millions
of to-dos and we are ready to manage yours as well!

Emoji Input by EmojiStuff.com



Allows you to see and input emoji on any website. Can replace Twitter and
Gmail style emoji with iPhone style emoji.

Buffer

Buffer is the best way to share great content to Twitter, Facebook and LinkedIn
from anywhere on the web, with just one click.

Evernote Web Clipper

Use the Evernote extension to save things you see on the web into your
Evernote account.

Tampermonkey
The most popular userscript manager for Blink-based browsers
feedly Mini
The easiest way to add content to your feedly.
Proxy SwitchySharp

Manage and switch between multiple proxies quickly & easily. Based on
“Proxy Switchy!” & “SwitchyPlus”

Pushbullet
Bringing together your devices, friends, and the things you care about.
RSS Feed Reader

Get a simple overview of your RSS and Atom feeds in the toolbar

For Mozilla Firefox : https://addons.mozilla.org/en-US/firefox/extensions/

Adblock Plus

Adblock Plus blocks all annoying ads, and supports websites by not blocking
unobtrusive ads by default (configurable).

Video DownloadHelper

The easy way to download and convert Web videos from hundreds of
YouTube-like sites.

NoScript Security Suite
The best security you can get in a web browser!

Allow active content to run only from sites you trust, and protect yourself
against XSS and Clickjacking attacks.

Ghostery

Protect your privacy. See who’s tracking your web browsing and block them
with Ghostery.


https://addons.mozilla.org/en-US/firefox/extensions/

Speed Dial [FVD]

FVD Speed Dial - Speed dial button, Online Synchronization, New Tab Start
Page, Organize bookmarks, Custom backgrounds, custom dials, organized
groups, most visited dials.

Tab Mix Plus

Tab Mix Plus enhances Firefox’s tab browsing capabilities. It includes such
features as duplicating tabs, controlling tab focus, tab clicking options, undo
closed tabs and windows, plus much more. It also includes a full-featured
session manager.

YouTube Video and Audio Downloader

Downloads YouTube videos in all available formats (FLV, MP4, WebM, and
3GP) with video quality of your choice. It also contains a pure JavaScript
library to extract the ORIGINAL audio file embedded in video files.

Web Developer

The Web Developer extension adds various web developer tools to the
browser.

X-notifier (for Gmail,Hotmail,Yahoo,AOL ...)
Notifier for gmail, yahoo, hotmail, aol and more webmails.

X-notifier(aka WebMail Notifier) checks your webmail accounts and notifies
the number of unread emails...

Supports : gmail, yahoo, hotmail, POP3/IMAP, facebook, twitter and more
Web of Trust - WOT

Find out which websites you can trust. WOT adds intuitive traffic light-style
icons next to search results and URLs to help you make informed decisions
about whether to visit a site or not.

FoxyProxy Standard

FoxyProxy is an advanced proxy management tool that completely replaces
Firefox’s limited proxying capabilities. For a simpler tool and less advanced
configuration options, please use FoxyProxy Basic.

Fastest Search - Browse/Shop Faster!

Search/browse/shop faster than ever! Ctrl-Shift-F for whole-word/regex/all
tabs/diacritic search;create custom engines;shopping assistant compares
price;Smart SearchBox;Preview results; Auto copy plain text, dnd save
image/open link.

DownThemAll!

The first and only download manager/accelerator built inside Firefox!



LastPass Password Manager

LastPass, an award-winning password manager, saves your passwords and
gives you secure access from every computer and mobile device.

AutoProxy

Are you concerned about your privacy? Or, are you blocked from some
websites by a firewall? And, are you arming yourself with a proxy? In that
case, AutoProxy is designed for you! A tool to help you use your proxy
automatically & efficiently.

KeeFox

Simple and secure password management. Login automatically, never forget
another password, stay in control of your passwords and improve their security.
Powered by the world-renowned KeePass Password Safe.

LeechBlock

LeechBlock is a simple productivity tool designed to block those time-wasting
sites that can suck the life out of your working day. All you need to do is
specify which sites to block and when to block them.

CHAPTER 4
USEFUL HACKING
SOFTWARE AND TOOLS

4.1 PASSWORD CRACKER SOFTWARE

A password cracker software, which is often referred to as a password recovery tool, can
be used to crack or recover the password either by removing the original password, after
bypassing the data encryption, or by outright discovery of the password. In the process of
password cracking, a very common methodology used to crack the user password is to
repeatedly make guesses for the probable password and perhaps finally hitting on the
correct one. It cannot be denied that whenever we are referring to cyber security,
passwords are the most vulnerable security links. On the other hand if the password is too
completed, the user might forget it. Password Cracker software are often used by the
hackers to crack the password and access a system to manipulate it. Do not unethically use
these software for hacking passwords.

In the next section you would be getting familiar with some of the popular Password
Cracker tools which are used by hackers for password cracking.

Click the software names to download the software from their website



* Ophcrack

e Medusa
 RainbowCrack
o  Wifuzz

e Brutus

+ LoOphtCrack

e Fgdump
e THC Hydra


http://ophcrack.sourceforge.net/
http://foofus.net/goons/jmk/medusa/medusa.html
http://project-rainbowcrack.com/
http://www.edge-security.com/wfuzz.php
http://www.hoobie.net/brutus/
http://www.l0phtcrack.com/
http://foofus.net/goons/fizzgig/fgdump/
https://www.thc.org/thc-hydra/

» John The Ripper
e Aircrack


http://www.openwall.com/john/
http://www.aircrack-ng.org/

e Cain And Abel

« IKECrack

4.2 WIRELESS HACKING TOOLS

Wireless Hacking Tools are those hacking tools which are used to hack into a wireless
network which is usually more susceptible to security threats. One must also ensure that
the network is completely secured against hacking or other malwares. The list of wireless
hacking tools which would be discussed now can be used to do a Penetration Testing for a
Wireless Network. This is an intentional attack on a network to detect security
vulnerabilities by accessing its data and functionality.

Click the software names to download the software from their website


http://www.oxid.it/cain.html
http://ikecrack.sourceforge.net/

» Aircrack-ng

 Kismet
e InSSIDer
« KisMAC

» Firesheep

» Airjack
« KARMA

 NetStumbler

* WeplLab
4.3 NETWORK SCANNING & HACKING TOOLS

Click the software names to download the software from their website


http://www.aircrack-ng.org/
http://www.kismetwireless.net/
http://www.inssider.com/
http://kismac-ng.org/
http://codebutler.com/firesheep/
http://sourceforge.net/projects/airjack/
http://www.wirelessdefence.org/Contents/KARMAMain.htm
http://www.netstumbler.com/
http://weplab.sourceforge.net/

Nmap

Nmap or Network Mapper is a free open source utility tool for network discovery and
security auditing solution for you. It is a flexible, powerful, portable and easy-to-use tool
that is supported by most of the operating systems like Linux, Windows, Solaris, Mac OS
and others.


http://nmap.org/

SuperScan

It is an multi-functional application that is designed for scanning TPC port. This is also a
pinger and address resolver. It also has useful features like ping, traceroute, Whols and
HTTP request. There is no need of installation as it is a portable application.


http://www.softpedia.com/get/Network-Tools/Network-IP-Scanner/SuperScan.shtml

Angry IP Scanner

It is a fast port and IP address scanner. It is a lightweight and cross-platform application
that has the capacity to scan the IP addresses in any range and also in their ports. It simply
pings each IP address.

4.4 PACKET CRAFTING TO EXPLOIT FIREWALL WEAKNESSES

Through Packet crafting technique, an attacker capitalizes your firewall’s vulnerabilities.
Here are some packet crafting tools.

Click the software names to download the software from their website


http://angryip.org/download/#windows

* Hping
Scapy
* Netcat

* Yersinia

 Nemesis

* Socat

4.5 TRAFFIC MONITORING FOR NETWORK RELATED HACKING

These tools allow users to monitor the websites one’s children or employees are viewing.
Here’s a list of some of these tools.

Click the software names to download the software from their website


http://www.hping.org/
http://nc110.sourceforge.net/
http://nc110.sourceforge.net/
http://www.yersinia.net/
http://nemesis.sourceforge.net/
http://www.dest-unreach.org/socat/doc/socat.html

Splunk

If you want to convert your data into powerful insights Splunk tools are the best options
for you. The Splunk tools are the leading platforms for operational intelligence. It can
collect any type of data from any machine in real time.


http://www.splunk.com/

Nagios

Nagios is the name for the industry standard in monitoring IT infrastructure. The Nagios
tools helps you monitor your entire IT infrastructure and have the capability to detect
problems well ahead they occur. It can also detect security breaches and share data
availability with stakeholders.


http://www.nagios.org/

Pof

It is versatile passive tool that is used for OS fingerprinting. This passive tool works well
in both Linux and Windows operating systems. It has the capability to detect the hooking
up of the remote system whether it is Ethernet, DSL or OC3.


http://www.pof.com/

Ngrep

Ngrep or network grep is a pcap-aware tool that allows you to extend hexadecimal or
regular expressions in order to match it against the data loads of the packet. It can
recognize IPv4/6, UDP, TCP, Ethernet, SLIP, PPP, FDDI and many others.


http://ngrep.sourceforge.net/

4.6 PACKET SNIFFERS TO ANALYZE TRAFFIC

These tools help capture and analyze incoming traffic on your website. Some of the
popular ones are listed below.

Click the software names to download the software from their website



*  Wireshark

* Tcpdump
* Ettercap
*  Dsniff

» EtherApe

e Paros


https://www.wireshark.org/
http://www.tcpdump.org/
http://ettercap.github.io/ettercap/
http://www.monkey.org/~dugsong/dsniff/
http://etherape.sourceforge.net/
http://sourceforge.net/projects/paros/

* Fiddler

* Ratproxy
- Sslstrip
4.7 ROOTKIT DETECTORS TO HACK FILE SYSTEM

This is a directory and file integrity checker. It checks the veracity of files and notifies the
user if there’s an issue.

Click the software names to download the software from their website


http://www.telerik.com/fiddler
https://code.google.com/p/ratproxy/
http://www.thoughtcrime.org/software/sslstrip/

 AIDE (Advanced Intrusion Detection Environment)

* Netfilter

* PF: OpenBSD Packet Filter

4.8 FUZZERS TO SEARCH VULNERABILITIES

Fuzzing is a term used by hackers for searching a computer system’s security
vulnerabilities. Here is a list of a few:

Click the software names to download the software from their website


http://aide.sourceforge.net/
http://www.netfilter.org/
http://www.openbsdindia.org/faq/pf/

e  Wfuzz
*  Wapiti
« W3af
4.9 FORENSICS

These tools are used for computer forensics, especially to sniff out any trace of evidence
existing in a particular computer system. Here are some of the most popular.

Click the software names to download the software from their website


https://code.google.com/p/skipfish/
http://www.edge-security.com/wfuzz.php
http://wapiti.sourceforge.net/
http://w3af.org/

Sleuth Kit

It is an open source digital intervention or forensic tool kit. It runs on varied operating
systems including Windows, Linux, OS X and many other Unix systems. It can be used
for analyzing disk images along with in-depth analysis of file system like FAT, Ext3,
HFS+, UFS and NTFS.


http://www.sleuthkit.org/

Helix

This is a Linux based incident response system. It is also used in system investigation and
analysis along with data recovery and security auditing. The most recent version of this
tool is based on Ubuntu that promises ease of use and stability.


http://www.dedoimedo.com/computers/helix.html

Maltego

It is an open source forensic and intelligence application. It can be used for gathering
information in all phases of security related work. It saves you time and money by
performing the task on time in smarter way.


http://www.paterva.com/web6/

Encase

Encase is the fastest and most comprehensive network forensic solution available in the
market. It is created following the global standard of forensic investigation software. It has
the capability of quickly gathering data from wide variety of devices.

4.10 DEBUGGERS TO HACK RUNNING PROGRAMS

These tools are utilized for reverse engineering binary files for writing exploits and
analyzing malware.

Click the software names to download the software from their website


https://www.guidancesoftware.com/products/Pages/encase-forensic/overview.aspx

GDB

Immunity Debugger

Netcat

Traceroute

Ping.eu

ol
-
-



http://www.sourceware.org/gdb/
http://www.immunityinc.com/products/debugger/
http://netcat.sourceforge.net/
http://www.yougetsignal.com/tools/visual-tracert/
http://ping.eu/
http://sourceforge.net/projects/htdig/
http://curl.haxx.se/

4.11 HACKING OPERATING SYSTEMS

There are numerous professionals who aspire to have a career as ethical hackers. Hacking
is not an easy task as it requires great insight about technology and programing. There are
specific operating systems as well that are specially designed for the hackers to use. These
operating systems have preloaded tools and technologies that hackers can utilize to hack.
This article offers a detailed overview of various operating systems that are built keeping
hacking in mind. All these operating systems are unique from each other and have proved
to be a great resource for the hackers around the world.

Click the software names to download the software from their website



Backtrack 5r3

This operating system is built keeping the most savvy security personnel in mind as
audience. This is also a useful tool even for the early newcomers in the information
security field. It offers quick and easy way to find and also update the largest database
available for the security tools collection till date.


http://www.backtrack-linux.org/downloads/

Kali Linux

This is a creation of the makers of BackTrack. This is regarded as the most versatile and
advanced penetration testing distribution ever created. The documentation of the software
is built in an easy format to make it the most user friendly. It is one of the must-have tools
for ethical hackers that is making a buzz in the market.


http://www.kali.org/

SELinux

Security Enhanced Linux or SELinux is an upstream repository that is used for various
userland tools and libraries. There are various capabilities like policy compilation, policy
management and policy development which are incorporated in this utility tool along with
SELinux services and utilities. The user can get the software as a tested release or from the
development repository.


http://sourceforge.net/projects/selinux/

Knoppix

The website of Knoppix offers a free open source live Linux CD. The CD and DVD that is
available contain the latest and recent updated Linux software along with desktop
environments. This is one of the best tools for the beginners and includes programs like
OpenOffice.org, Mozilla, Konqueror, Apache, MySQL and PHP.


http://knoppix.net/

BackBox Linux

It is a Linux distribution that is based on Ubuntu. If you want to perform security
assessment and penetration tests, this software is the one that you should have in your
repository. It proactively protects the IT infrastructure. It has the capability to simplify the
complexity of your IT infrastructure with ease as well.


http://www.backbox.org/

Pentoo

It is security focused live CD that is created based on Gentoo. It has a large number of
customized tools and kernels including a hardened kernel consisting of aufs patches. It can
backport Wi-Fi stack from the latest kernel release that is stable as well. There are
development tools in Pentoo that have Cuda/OPENCL cracking.

Matriux Krypton

If you are looking for a distro to be used in penetration testing and cyber forensic
investigation, then Matriux Krypton is the name that you can trust. This is a Debian based
GNU/Linux security distribution. It has more than 340 powerful tools for penetration
testing and forensics; additionally, it contains custom kernel 3.9.4.


http://www.pentoo.ch/about
http://sourceforge.net/projects/matriux/

NodeZero

This is regarded as the specialist tool that is specifically designed for security auditing and
penetration testing. It is a reliable, stable and powerful tool to be used for this purpose and
is based on the current Ubuntu Linux distribution. It is a free and open source system that
you can download from the website.


http://www.nodezero-linux.org/

Blackbuntu

It is free and open source penetration testing distribution available over the internet. It is
based on Ubuntu 10.10, which is designed specifically for the information security
training students and professional. It is fast and stable yet a powerful tool that works
perfectly for you. This software is a recommendation from most of the users.


http://sourceforge.net/projects/blackbuntu/

Blackbuntu

It is free and open source penetration testing distribution available over the internet. It is
based on Ubuntu 10.10, which is designed specifically for information security, training
students and professionals. It is fast and stable, yet a powerful tool that works perfectly for
you. This software is a recommendation from most of the users.


http://sourceforge.net/projects/blackbuntu/

Samurai Web Testing Framework

It is a live Linux environment that is designed in such a way that it functions as a web-pen
testing environment. The software CD contains tools and programs that are open source
and free. The tool selection is based on the ones that the company themselves use for
security of their IT infrastructure.


http://samurai.inguardians.com/

WEAKERTH4N

It’s a great pentesting distro comprising of some innovative pentesting tools. The software
uses Fluxbox and is built using Debian Squeeze. One of it’s popular features is its ability
to hack old Android based systems.


http://weaknetlabs.com/main/?page_id=479

CAINE (Computer Aided Investigative Environment)

It is an Italian GNU/Linux live distribution list that was created as project of Digital
Forensic. It offers a complete forensic environment. This environment is organized in such
a way that it integrates the existing software tools and software module, and finally throws
the result in the form of friendly graphical interface.


http://www.caine-live.net/

Bugtraq

It is one of the most stable and comprehensive distributions. It offers stable and optimal
functionalities with stable manger in real-time. It is based upon 3.2 and 3.4 kernel Generic
that is available in both 32 and 64 Bits. Bugtraq has a wide range of tools in various
branches of the kernel. The features of the distribution vary as per your desktop
environment


http://www.bugtraq-team.com/downloads

DEFT

DEFT is a distribution that is created for computer forensics. It can run in live stream on
the system without corrupting the device. The system is based on GNU/Linux and the user
can run this live using CD/DVD or USB pendrive. DEFT is now paired with DART,
which is a forensic system.


http://www.deftlinux.net/

Helix

There are various versions of Helix released by e-fense that are useful for both home and
business use. The Helix3 Enterprise is a cyber-security solution offered by this
organization that provides incident response. It throws live response and acquires volatile
data. Helix3 Pro is the newest version in the block of Helix family products.


http://www.e-fense.com/products.php

4.12 ENCRYPTION TOOLS

Times are changing and spying has become a common phenomenon everywhere. There
have been increasing instances where even the governments have been found to be spying
on their citizens from time to time. This is one of the prime reasons why the importance of
Encryption has increased manifold. Encryption tools are very important because they keep
the data safe by encrypting it so that even if someone accesses the data, they can’t get
through the data unless they know how to decrypt the data. These tools use algorithm
schemes to encode the data to prevent unauthorized access to the encrypted data.

Some of the popular Encryption Tools will be listed below:

Click the software names to download the software from their website



TrueCrypt

TrueCrypt is open source encryption tool which can encrypt a partition in the Windows
environment (except Windows 8); it’s equipped for creating a virtual encrypted disk in a
file. Moreover, it has the capability to encrypt the complete storage device. TrueCrypt can
run on different operating systems like Linux, Microsoft Windows and OSX. TrueCrypt
stores the encryption keys in the RAM of the computer.


http://truecrypt.sourceforge.net/

OpenSSH

OpenSSH is the short name for Open Secure Shell and is a free software suite which is
used to make your network connections secured. It uses the SSH protocol to provide
encrypted communication sessions in a computer network. It was designed originally as an
alternative to the Secure Shell Software developed by SSH Communications Security. The
tool was designed as a part of the OpenBSD project.


http://www.openssh.com/

PulTY

It an open source encryption tool available on both UNIX and Windows operating system.
It is a free implementation of SSH (Secure Shell) and Telnet for both Windows as well as
UNIX. The beauty of this tool is that it supports many network protocols like Telnet, SCP,
rlogin, SSH and raw socket connection. The word PuTTY has no specific meaning,
however as in UNIX tradition, tty is a terminal name.


http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html

OpenSSL

OpenSSL is an open source encryption tool which implements the TLS and SSL protocols.
OpenSSL’s core library is written in the C programming language. The fundamental
cryptographic functions are implemented by it. OpenSSL versions are available for
operating systems like UNIX, Solaris, Linux and Mac OS X. The project was undertaken
in 1988 with the objective of inventing free encryption tools for the programs being used
on the internet.


http://www.openssl.org/

Tor

Tor is a free encryption tool and has the capability to provide online anonymity as well as
censorship resistance. Internal traffic is directed through a free network which consists of
more than five thousand relays so that the user’s actual location can be hidden. It is
difficult to track the Internet activities like visiting web sites and instant messages; the
most important goal of this tool is to ensure the personal privacy of the users.


http://www.torproject.org.in/

OpenVPN

It is an open source tool for the implementation of virtual private network techniques so
that secured site-to-site or point-to-point connections using routers or bridges are possible,
also remote access is possible. OpenVPN offers the users a secured authentication process
by using secret keys which are pre-shared.


http://openvpn.net/

Stunnel

Stunnel is a multi-platform open source tool which is used to ensure that both the clients
and the servers get secured encrypted connections. This encryption software can operate
on a number of operating system platforms like Windows as well as all operating systems
which are UNIX like. Stunnel depends upon a distinct library like SSLeay or OpenSSL to
implement the protocols (SSL or TLS)


https://www.stunnel.org/index.html

KeePass

KeePass is an open source as well as free password management tool for the Microsoft
Windows as well as unofficial ports for operating systems such as iOS, Linux, Android,
Mac OS X and Windows Phone. All the usernames, passwords and all other fields are
stored by KeePass in a secured encrypted database. This database in turn is protected by a
single password.


http://keepass.info/

4.13 INTRUSION DETECTION SYSTEM AND THE IDS TOOLS

An Intrusion Detection System is a software application or a device which is equipped to
do network or system monitoring activities for any malicious threats and sends reports to
the management station. Intrusion detection tools can help in identifying potential threats
which can be dangerous for the system or the network.

Click the software names to download the software from their website



* Snort

* NetCop

4.14 HACKING VULNERABILITY EXPLOITATION TOOLS

A tool which identifies whether a remote host is vulnerable to a security attack and tries to
protect the host by providing a shell or other function remotely, is called a Vulnerability
Exploitation tool. Here is a list of some popular ones:

Click the software names to download the software from their website


https://www.snort.org/
http://sourceforge.net/projects/netcop/

* Metasploit

» Sqlmap
* Sqlninja

» Social Engineer Toolkit

* NetSparker

e BeEF
 Dradis
4.15 VULNERABILITY SCANNERS

The scanners which assess the vulnerability of a network or a computer to security attacks
are known as Vulnerability Scanners. The tools might function differently, however all of
them aim to provide an analysis on how vulnerable the system or a network is. Here is a
list of the best ones:

Click the software names to download the software from their website


http://www.metasploit.com/
http://sqlmap.org/
http://sqlninja.sourceforge.net/
https://www.trustedsec.com/downloads/social-engineer-toolkit
https://www.netsparker.com/web-vulnerability-scanner/
http://beefproject.com/
http://dradisframework.org/

e Nessus

*  OpenVAS
* Nipper

* Secunia PSI

* Retina
* QualysGuard
* Nexpose
4.16 WEB VULNERABILITY SCANNERS

While vulnerability scanners are meant for your system, the web vulnerability scanners
assess the vulnerability of web applications. It identifies the security vulnerabilities that
your app might have by conducting various tests.

Click the software names to download the software from their website


http://www.tenable.com/products/nessus
http://www.openvas.org/
http://sourceforge.net/projects/nipper/
http://secunia.com/products/consumer/psi/sys_req/
http://www.beyondtrust.com/Products/RetinaNetworkSecurityScanner/
https://www.qualys.com/enterprises/qualysguard/
http://www.rapid7.com/products/nexpose/compare-downloads.jsp

Burp Suite
Webscarab

Websecurify
Nikto
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http://www.portswigger.net/burp/
https://www.owasp.org/index.php/Category:OWASP_WebScarab_Project
http://www.websecurify.com/
http://www.cirt.net/nikto2
http://w3af.org/
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